Copyright © 2016 PTC Inc. and/or Its Subsidiary Companies. All Rights Reserved.

User and training guides and related documentation from PTC Inc. and its subsidiary companies (collectively "PTC") are subject to the copyright laws of the United States and other countries and are provided under a license agreement that restricts copying, disclosure, and use of such documentation. PTC hereby grants to the licensed software user the right to make copies in printed form of this documentation if provided on software media, but only for internal/personal use and in accordance with the license agreement under which the applicable software is licensed. Any copy made shall include the PTC copyright notice and any other proprietary notice provided by PTC. Training materials may not be copied without the express written consent of PTC. This documentation may not be disclosed, transferred, modified, or reduced to any form, including electronic media, or transmitted or made publicly available by any means without the prior written consent of PTC and no authorization is granted to make copies for such purposes. Information described herein is furnished for general information only, is subject to change without notice, and should not be construed as a warranty or commitment by PTC. PTC assumes no responsibility or liability for any errors or inaccuracies that may appear in this document.

The software described in this document is provided under written license agreement, contains valuable trade secrets and proprietary information, and is protected by the copyright laws of the United States and other countries. It may not be copied or distributed in any form or medium, disclosed to third parties, or used in any manner not provided for in the software licenses agreement except with written prior approval from PTC.

UNAUTHORIZED USE OF SOFTWARE OR ITS DOCUMENTATION CAN RESULT IN CIVIL DAMAGES AND CRIMINAL PROSECUTION.

PTC regards software piracy as the crime it is, and we view offenders accordingly. We do not tolerate the piracy of PTC software products, and we pursue (both civilly and criminally) those who do so using all legal means available, including public and private surveillance resources. As part of these efforts, PTC uses data monitoring and scouring technologies to obtain and transmit data on users of illegal copies of our software. This data collection is not performed on users of legally licensed software from PTC and its authorized distributors. If you are using an illegal copy of our software and do not consent to the collection and transmission of such data (including to the United States), cease using the illegal version, and contact PTC to obtain a legally licensed copy.

Important Copyright, Trademark, Patent, and Licensing Information: See the About Box, or copyright notice, of your PTC software.

UNITED STATES GOVERNMENT RIGHTS

PTC software products and software documentation are “commercial items” as that term is defined at 48 C.F. R. 2.101. Pursuant to Federal Acquisition Regulation (FAR) 12.212 (a)-(b) (Computer Software) (MAY 2014) for civilian agencies or the Defense Federal Acquisition Regulation Supplement (DFARS) at 227.7202-1(a) (Policy) and 227.7202-3 (a) (Rights in commercial computer software or commercial computer software documentation) (FEB 2014) for the Department of Defense, PTC software products and software documentation are provided to the U.S. Government under the PTC commercial license agreement. Use, duplication or disclosure by the U.S. Government is subject solely to the terms and conditions set forth in the applicable PTC software license agreement.

PTC Inc., 140 Kendrick Street, Needham, MA 02494 USA
## Contents

Technical Support ................................................................................................. 6  
Documentation for PTC Products ................................................................. 6  
Comments .......................................................................................................... 7  

Overview ............................................................................................................. 9  

Prerequisites ....................................................................................................... 11  

Licenses ................................................................................................................ 17  

Installation and Configuration ............................................................................ 19  
  Installation ......................................................................................................... 20  
  Configuring Windchill ..................................................................................... 45  

Integrating with Your CAD Application ............................................................ 73  
  Working with Creo Parametric ....................................................................... 74  
  Installing Windchill Workgroup Manager for a Third-Party CAD Application .................................................................................. 99  

Moving Forward: Ongoing Windchill Administration ......................................... 101  
  Business Administrative Tasks ...................................................................... 103  
  System Administrative Tasks ........................................................................ 119  

Using the Windchill Help Center ........................................................................ 149
About This Guide
The *PTC Windchill PDM Essentials Getting Started Guide* walks you through the installation, configuration, and administration procedures unique to PTC Windchill PDM Essentials.

In addition, the guide provides detailed information about Creo Parametric integration and links to additional Windchill documentation to consider as you set up PTC Windchill PDM Essentials at your site.

Technical Support
Contact PTC Technical Support through the PTC website, or by phone, email, or fax if you encounter problems using this product or the product documentation. The PTC eSupport portal provides the resources and tools to support your PTC Windchill implementation:

https://support.ptc.com/appserver/cs/portal/

For complete details, see the *PTC Customer Support Guide*:

http://support.ptc.com/appserver/support/csguide/csguide.jsp

You must have a Service Contract Number (SCN) before you can receive technical support. If you do not know your SCN, see “Preparing to contact TS” on the *Processes* tab of the *PTC Customer Support Guide* for information about how to locate it.

Documentation for PTC Products
You can access PTC documentation using the following resources:

- **PTC Windchill Help Center**—The PTC Windchill Help Center includes all PTC Windchill documentation. You can browse the entire documentation set, or use the search capability to perform a keyword search. To access the PTC Windchill Help Center, you can:
  
  ○ Click any help icon in PTC Windchill
  ○ Select **Help ▶ Windchill Help Center** from the **Quick Links** menu at the top right of any PTC Windchill page
  ○ Use the following link to access all PTC help centers:
    
    https://support.ptc.com/appserver/cs/help/help.jsp

- **Reference Documents** website—The Reference Documents website is a library of all PTC guides:

  http://support.ptc.com/appserver/cs/doc/refdoc.jsp

A Service Contract Number (SCN) is required to access the PTC documentation from the Reference Documents website. If you do not know your SCN, see “Preparing to contact TS” on the *Processes* tab of the *PTC Customer Support Guide* for information about how to locate it:
When you enter a keyword in the **Search Our Knowledge** field on the PTC eSupport portal, your search results include both knowledge base articles and PDF guides.

**Comments**

PTC welcomes your suggestions and comments on its documentation. To submit your feedback, you can:

- Send an email to documentation@ptc.com. To help us more quickly address your concern, include the name of the PTC product and its release number with your comments. If your comments are about a specific help topic or book, include the title.

- Click the feedback icon ![PTC](image) in the PTC Windchill Help Center toolbar and complete the feedback form. The title of the help topic you were viewing when you clicked the icon is automatically included with your feedback.
Overview

PTC Windchill PDM Essentials is a preconfigured, packaged solution designed for rapid, small deployments by customers with basic MCAD data management needs. The package contains everything needed for basic CAD data management except the operating system (OS).

Summary

• Microsoft SQL Server 2012 is bundled with PTC Windchill PDM Essentials and is automatically installed and configured. This bundled SQL server version is licensed with, and can be used only with PTC Windchill PDM Essentials.

• The following Windchill capabilities are included and preconfigured in PTC Windchill PDM Essentials:
  ○ Support for managing Creo Parametric CAD documents
  ○ Support for managing documents (PDF, Word, Excel, PowerPoint, TXT)
  ○ Server-side representation publishing and client-side viewing
    ✦ Creo View Lite is included for client 3-D viewing and markup.
    ✦ Creo Parametric CAD worker, publishing adapter, and the associated license are included and automatically configured for publishing
  ○ Windchill Directory Server (for managing users)
  ○ The following Windchill Workgroup Manager products are bundled and installed on the server and available for client deployment.
    ✦ Windchill Workgroup Manager for Creo Illustrate
    ✦ Windchill Workgroup Manager for Creo Schematics
    ✦ Windchill Workgroup Manager for Creo Elements/Direct Drafting
    ✦ Windchill Workgroup Manager for Creo Elements/Direct Modeling
    ✦ Windchill Workgroup Manager for AutoCAD
- Windchill Workgroup Manager for Autodesk Inventor
- Windchill Workgroup Manager for SolidWorks
- Windchill Workgroup Manager for Mathcad
- Windchill Workgroup Manager for Arbortext IsoDraw

- The following Windchill capabilities are excluded:
  - No support for parts (WTParts), part configurations, or advanced configuration options (only CAD documents and documents, such as Microsoft Word or text documents, are supported).
  - No support for content replication
  - No support for change objects
  - No support for indexed content search (Windchill Solr is not installed)

◆ Note
  WTParts are Windchill parts. CAD data for Creo Parametric parts and SolidWorks parts is managed in Windchill as CAD documents.

◆ Note
  Attribute search is supported.
Prerequisites

PTC Windchill PDM Essentials is deployed on a single physical or virtual machine on which Windows Server 2008 R2 or Windows Server 2012 is installed.

Note

Multi-core processors on a single physical or virtual machine eliminate the necessity for multiple machines in order to support up to 25 active CAD users and up to 200 active web browser users. For this reason, there is no provision for supporting a multi-machine deployment.
Server Hardware Requirements

- 12GB of available RAM (16 with concurrent server-side publishing)

**Note**

You must have a minimum of 8GB of available RAM on a physical or virtual machine in order for the installation environment to be verified by the Windchill Installation Assistant. Ensure that there is at least 8GB of available RAM.

If the server is intended only as a demonstration or test server, you can disable this check in the `WindchillSetup.exe.config` file before installation. After obtaining and opening the media (see Obtaining the PTC Windchill PDM Essentials Media on page 32), this file is located in the media directory. Set the following parameter value:

```xml
<appSettings>
  <add key="preCheckRAM" value="false"/>
</appSettings>
```

For customers that regularly work with larger assemblies that include more than 500 components and require more than 2 GB of RAM to open in Creo Parametric or another CAD application, use the following calculation to determine the amount of RAM required: add the total amount of RAM needed to open your largest assembly in Creo Parametric to the base configuration listed above. For example, if the largest assembly requires 8 GB of RAM to open in Creo Parametric, and concurrent server-side publishing is enabled, the calculation for the required amount of RAM is 16+8=24 GB.

- 2 processors (4 recommended with concurrent server-side publishing)
- 50 GB of disk space for software components
- Disk space for file content (CAD documents and documents, such as Microsoft Word or text documents). Use the following steps to calculate required disk space:
  1. Estimate current total file space used for CAD and office files
  2. Estimate rate of growth over 3-5 years (for example, 30% per year)
  3. Compute estimated total needs over 5 years

Disk space = [(Current file content) + (.3/year*Current file content)*(5years)]
Ensure that the media used for backups can also accommodate the projected growth.

- The server name cannot include an underscore (for example, PDM_Essentials_Server). Rename the server, removing underscores, if necessary
- Compressed volumes are not supported for Microsoft SQL Server and cannot be used for PTC Windchill PDM Essentials

**Server Software Requirements**

- **Windows Server**:
  - Windows Server 2012 64-bit (Standard Edition or higher)
  - Windows Server 2008 R2 64-bit (Standard Edition or higher)

- **Java Runtime Environment (JRE) Version 7, Update 51 or later**

**Caution**

No existing versions of Windchill, Creo Parametric, or SQL Server can be currently installed. Double check for any installations and, if they exist, uninstall them and restart the server. After reboot, ensure that there are no Windchill, Creo Parametric, or SQL Server components installed before installing PTC Windchill PDM Essentials.

**Client Software Requirements**

- **Windows Operating System**
  - Windows 7 (32-bit or 64-bit)
  - Windows 8 (32-bit or 64-bit)
  - Windows 8.1 (32-bit or 64-bit)
- **Solaris 10 (SPARC & x64)**
- **Macintosh OS X 10.10.x**
- **Web Browser**
  - Internet Explorer
    - For Windows 7: Internet Explorer 8, 9, 10, 11(32-bit or 64-bit)
    - For Windows 8: Internet Explorer 10 (32-bit or 64-bit)
    - For Windows 8.1: Internet Explorer 11 (32-bit or 64-bit)
  - Mozilla Firefox ESR 31.0.x
  - Google Chrome 39.0 or higher
  - Apple Safari 8.0.x or higher
• Java Plugin:
  1. Version 7, Update 37 or higher
  2. Version 8, Update 20 or higher

• Windchill Desktop Integration (Windows 7 and Windows 8 clients only):
  ○ Microsoft Office 2007, 2010, or 2013
  ○ Microsoft Outlook 2007, 2010, or 2013

Client CAD Application Compatibility

PTC Windchill PDM Essentials is optimized for use with Windows Server and Microsoft SQL Server to support up to about 25 CAD users and up to about 200 web users.

The following CAD application versions are compatible with PTC Windchill PDM Essentials:

• Version compatibility for Creo Parametric (formerly known as Pro/ENGINEER):
  ○ Creo Elements/Pro 5.0 M260 or later
  ○ Creo Parametric 2 M080 or later, 3 F000 or later
Refer to the following link for the latest Creo Parametric compatibility matrix: http://www.ptc.com/view?im_dbkey=124498.

⚠️ Caution

You must use the same major version of Creo Parametric (Creo Parametric 2 or Creo Parametric 3) for both server-side publishing and the CAD client working with PTC Windchill PDM Essentials. For example, if you use Creo Parametric 2 for server-side publishing, you must use Creo Parametric 2 as the CAD client. Or, if you use Creo Parametric 3 as the CAD client, you must use Creo Parametric 3 for server-side publishing.

PTC Creo Parametric 2 M110 is bundled with PTC Windchill PDM Essentials 10.2 M020 for server-side publishing. Therefore, Creo Parametric 2 is the supported CAD client. To use Creo Parametric 3 as the CAD client with PTC Windchill PDM Essentials 10.2 M020, you must either upgrade the server instance to Creo Parametric 3, or uninstall the server instance of Creo Parametric 2 and install Creo Parametric 3. Then, you must configure a Creo worker. For more information about upgrading or installing Creo Parametric, refer to the Reference Documents page of the PTC support website for upgrade and installation guides: https://www.ptc.com/appserver/cs/doc/refdoc.jsp. For more information about configuring a Creo worker, refer to the following article: https://www.ptc.com/appserver/cs/view/solution.jsp?n=CS34814.

- Creo Elements/Direct Modeling 18.1 M040, M050, or M070; 19.0 F000 or M010
- Creo Elements/Direct Drafting 18.1 M040, M050, M060, or M070; 19.0 F000 or M010
- Creo Illustrate 2.0 M040 and 3.0 M020
- Creo Schematics 2.0 M010 or later, 3.0
- Mathcad 15 M020, M030 or later
- Mathcad Prime 3.0 F000 or later

Refer to the following link for the latest Windchill Workgroup Manager compatibility matrix: http://www.ptc.com/view?im_dbkey=157177.

- Version compatibility for third-party CAD applications:
  - AutoCAD 2012, 2013, 2014, and 2015 (AutoCAD, AutoCAD Mechanical, and AutoCAD Electrical)

Refer to the following link for the latest third-party CAD applications compatibility matrix: http://www.ptc.com/view?im_dbkey=157177.

Note
For a detailed list of all available software and hardware compatibility matrices, see http://www.ptc.com/partners/hardware/current/support.htm.

Note
Integration of PTC Windchill PDM Essentials with a third-party CAD application requires the installation of a workgroup manager (which is included) and the registering of the CAD client with the server. For more information, see Integrating with Your CAD Application on page 73.
Licenses

A SQL Server 2012 Standard Runtime edition is bundled with PTC Windchill PDM Essentials and is licensed as part of a package seat. This bundled SQL Server can only be used with PTC Windchill PDM Essentials.

If you wish to use the publishing functionality, you must have available a valid Windchill Visualization Adapter license (for the CAD publishing). This license is checked out when the system is enabled for publishing, a publishing job is running, and a CAD worker is active. The Windchill Visualization Adapter license (part number: PKG-5055-F) must be ordered through your PTC partner. There is no extra charge, but a customer can only order this license once. When ordering this package, you must provide the hostID of your server. You will receive a license file from PTC that you must import into your FlexNet license server in the same way as any other Creo Parametric module.

You must configure your FlexNet license server and add the Visualization Adapter license before you install PTC Windchill PDM Essentials. For more information about installing a Windchill Visualization Adapter FlexNet license on your license server, see the Specifying License Entry for Previously Generated License Files section (under Configuring Licenses for the Creo Applications > Generating or Updating Licenses) of the Installing Creo 2.0: Creo Parametric, Creo Direct, Creo Layout, Creo Simulate, and Creo Options Modeler document located at the following URL: http://www.ptc.com/cs/help/creo_hc/creo20_hc/common/books/install.pdf.

Additionally, dedicate the publishing license for use by the Creo Parametric publishing client on the PTC Windchill PDM Essentials server. For details, see the following URL: https://www.ptc.com/appserver/cs/view/solution.jsp?n=CS44898
4

Installation and Configuration

Installation ................................................................. 20
Configuring Windchill .................................................. 45

PTC Windchill PDM Essentials streamlines the process of installing and configuring Windchill, automating much of the work and providing an intuitive **Windchill Installation Assistant** and **Windchill Setup Assistant** to walk you through the process.
Installation

The installation portion of PTC Windchill PDM Essentials involves acquiring the package, and then running a simple installation assistant that specifies installation settings and installs Windchill.

About the Installation

The PTC Windchill PDM Essentials installation configures the system as follows:

• Windchill is configured as a Windows service
  
  This service automatically starts and stops all the Windchill processes in the proper sequence. When the server is rebooted, the Windchill processes are automatically started in the proper sequence.

• SQL Server database is installed and configured
  
  SQL Server 2012 Standard Edition (embedded runtime version) is automatically installed, configured, and optimized for Windchill dedicated use.

  
  Note
  
  PTC Windchill PDM Essentials cannot be connected to an existing SQL server installation.

• A file vault is automatically configured to manage your CAD and office files
  
  The deployment automatically configures a single file vault (external to the database but on the same server machine) with automatic folder creation enabled so that you do not have to perform any vault management (other than to ensure that the vault location has sufficient space for all the versions saved and for expected growth).

  
  Note
  
  Older versions are not automatically purged. Manually purge older versions in order to manage space. For more information, see Managing Space on the File Vault on page 119.

• Windchill Directory Server is automatically configured and backed up
  
  The Windchill Directory Server manages users and is automatically configured with the system. A Lightweight Directory Interchange Format (LDIF) file is automatically created as a directory backup once a day at 1:00 a.
The eight most recent backups are saved in the WindchillLDIFBackup subdirectory of the File Vault location you specify on the Configuration page of the installation assistant detailed below.

- Apache Tomcat webserver and servlet engine is automatically configured. This webserver manages the display of web pages and the handling of user requests. It is automatically configured to use available ports and optimized for Windchill use.

- Server-driven publishing is automatically configured to generate thumbnail and 3D visualization formats when CAD files are checked in.

A Creo CAD worker is automatically installed and configured as part of the system. Server-side publishing can be enabled or disabled during the Windchill Setup Assistant and the publishing schedule can be specified using WVS Job Scheduler Administration. By default, a thumbnail and 3D image is automatically created when a drawing is saved or checked in. The system can be configured to publish during non-working hours if the server cannot handle the publishing load on top of the CAD and browser client loads.

⚠️ Caution ⚠️

You must use the same major version of Creo Parametric (Creo Parametric 2 or Creo Parametric 3) for both server-side publishing and the CAD client working with PTC Windchill PDM Essentials. For example, if you use Creo Parametric 2 for server-side publishing, you must use Creo Parametric 2 as the CAD client. Or, if you use Creo Parametric 3 as the CAD client, you must use Creo Parametric 3 for server-side publishing.

PTC Creo Parametric 2 M110 is bundled with PTC Windchill PDM Essentials 10.2 M020 for server-side publishing. Therefore, Creo Parametric 2 is the supported CAD client. To use Creo Parametric 3 as the CAD client with PTC Windchill PDM Essentials 10.2 M020, you must either upgrade the server instance to Creo Parametric 3, or uninstall the server instance of Creo Parametric 2 and install Creo Parametric 3. Then, you must configure a Creo worker. For more information about upgrading or installing Creo Parametric, refer to the Reference Documents page of the PTC support website for upgrade and installation guides: https://www.ptc.com/appserver/cs/doc/refdoc.jsp. For more information about configuring a Creo worker, refer to the following article: https://www.ptc.com/appserver/cs/view/solution.jsp?n=CS34814.

For more information about the Job Scheduler, see the WVS Job Scheduler Administration Help Center topic.
Installing PTC Windchill PDM Essentials

Preparing for the Installation

Before beginning the installation, make sure your environment is set up correctly. For more information, see Prerequisites on page 11.

Note

You must have a minimum of 8GB of available RAM on a physical or virtual machine in order for the installation environment to be verified by the Windchill Installation Assistant. Ensure that there is at least 8GB of available RAM.

If the server is intended only as a demonstration or test server, you can disable this check in the WindchillSetup.exe.config file before installation. After obtaining and opening the media (see Obtaining the PTC Windchill PDM Essentials Media on page 32), this file is located in the media directory.

Set the following parameter value:

```xml
<appSettings>
  <add key="preCheckRAM" value="false"/>
</appSettings>
```

Preparing the Server for Installation

In particular, the server should be set up appropriately to prepare it for the installation. First, ensure that there are no existing installations of Windchill, Creo Parametric, or SQL Server. If any installations exist, uninstall and restart the server before continuing. Then, follow the directions in the following sections, based on the Operating System of your server:

Note

Be sure you have administrator privileges on the server machine.

Server Preparation for Windows Server 2008 R2

- Ensure that Windows Server 2008 R2 Service Pack 1 (SP1) is installed
- Install or enable .NET Framework 3.5.1
• Install .NET Framework 4 update: KB2533523 (Microsoft .NET Framework 4 Reliability Update 1 KB2533523)

• To optimize Microsoft Internet Explorer for Windchill, ensure that the Enhanced Security Configuration is disabled on the server:
  1. In Server Manager, on the left navigation pane, select Server Manager (Server Name).

  ![Server Manager](image)

  2. Under Security Information, in the list of links on the right, click Configure IE ESC.

  ![Configure IE ESC](image)
The **Internet Explorer Enhanced Security Configuration** window appears.

![Internet Explorer Enhanced Security Configuration](image)

3. Under **Administrators**, select **Off**, and then click **OK**.
   - Temporarily turn off Windows Firewall for the domain:
     1. In **Server Manager**, on the left navigation pane, select **Server Manager** (Server Name).
        ![Server Manager](image)
        2. Under **Security Information**, in the list of links on the right, click **Go to Windows Firewall**.
3. Under **Domain network settings**, select **Turn off Windows Firewall (not recommended)**, and then click **OK**.

**Server Preparation for Windows Server 2012**

- Enable .NET Framework 3.5.1:
  - 1. In **Server Manager**, on the left navigation pane, select **Dashboard**.
  
  ![Server Manager Dashboard](image)

  2. Under **Roles and Server Groups**, in the **Local Server** section, click **Manageability**.

  ![Local Server Manageability](image)

  3. In the **Manage** menu, select **Add Roles and Features**. The **Add Roles and Features Wizard** opens.
4. On the Before you begin page, click Next.
5. On the Select installation type screen, select Role-based or feature-based installation and click Next.
6. On the **Select destination server** page, select **Select a server from the server pool**, find the applicable server in the **Server Pool** table, and then click **Next**.

7. On the **Select features** page, expand **.NET Framework 3.5 Features**, select **.NET Framework 3.5 (includes .NET 2.0 and 3.0)**, and then click **Install**.

- To optimize Microsoft Internet Explorer for Windchill, ensure that the Enhanced Security Configuration is disabled on the server:
  1. In **Server Manager**, on the left navigation pane, select **Dashboard**.
  2. Under **Roles and Server Groups**, in the **Local Server** section, click **Manageability**.
3. Under Properties, click the **IE Enhanced Security Configuration** value, which is currently set to **On**.

   ![](image1.png)

   The **Internet Explorer Enhanced Security Configuration** window appears.

4. Under **Administrators**, select **Off**, and then click **OK**.

   ![](image2.png)
Temporarily turn off Windows Firewall for the domain:

1. In **Server Manager**, on the left navigation pane, select **Dashboard**.

2. Under **Roles and Server Groups**, in the **Local Server** section, click **Manageability**.
3. Under **Properties**, click the **Windows Firewall** value, which is currently set to **Domain: On**.

![Windows Firewall Settings](image)

The **Customize Settings** window appears.

4. Under **Domain network settings**, select **Turn off Windows Firewall (not recommended)**, and then click **OK**.

**Additional Server Preparation**

In addition to the above preparation steps that are dependant on your server’s Operating System, perform the below preparation steps for Windows Server 2008 R2 and Windows Server 2012:

- Ensure that Java Runtime Environment (JRE) Version 7, Update 5 or later is installed.

  For more information on determining which version of JRE is installed, refer to the following [online procedure](#).

- Ensure that you have a PDF reader installed on the server (such as Adobe Acrobat). This is needed to open and read the PDF documentation included in the PTC Windchill PDM Essentials media.

- Configure the server if there is no corporate domain name server.

If you are installing in an environment where there is no domain name server, you need to configure your Windchill Server as a workgroup and add a domain extension for the workgroup:

1. On the server machine, click **Start**, right-click **Computer**, and then select **Properties**.

2. In the **Properties** window, select the **Computer Name** tab, and then click **Change**.
The **Computer Name/Domain Changes** dialog box opens.

3. In the **Member of** section, select **Workgroup**, and then type a name for the workgroup.

4. Click **More** to open the **DNS Suffix and NetBIOS Computer Name** dialog box.

5. Type a fully qualified domain name in the **Primary DNS suffix of this computer** field, and then click **OK**.

6. Click **OK** to accept the change to Workgroup and to close the **Computer Name/Domain Changes** dialog box.

- Reboot the server to ensure that Microsoft Windows does not have existing reboot requests pending.
Adding the Publishing License to Your FlexNET License Server

If you wish to use the publishing functionality, you must have available a valid Windchill Visualization Adapter license (for the CAD publishing). This license is checked out when the system is enabled for publishing, a publishing job is running, and a CAD worker is active. The Windchill Visualization Adapter license (part number: PKG-5055-F) must be ordered through your PTC partner. There is no extra charge, but a customer can only order this license once. When ordering this package, you must provide the hostID of your server. You will receive a license file from PTC that you must import into your FlexNet license server in the same way as any other Creo Parametric module.

You must configure your FlexNet license server and add the Visualization Adapter license before you install PTC Windchill PDM Essentials. For more information about installing a Windchill Visualization Adapter FlexNet license on your license server, see the Specifying License Entry for Previously Generated License Files section (under Configuring Licenses for the Creo Applications > Generating or Updating Licenses) of the Installing Creo 2.0: Creo Parametric, Creo Direct, Creo Layout, Creo Simulate, and Creo Options Modeler document located at the following URL: http://www.ptc.com/cs/help/creo_hc/creo20_hc/common/books/install.pdf.

Additionally, dedicate the publishing license for use by the Creo Parametric publishing client on the PTC Windchill PDM Essentials server. For details, see the following URL: https://www.ptc.com/appserver/cs/view/solution.jsp?n=CS44898

Running the Installation Assistant

Obtaining the PTC Windchill PDM Essentials Media

PTC Windchill PDM Essentials contains everything you need to deploy Windchill. Obtain the media using one of the following methods:

- Order the USB flash drive that contains the media from your PTC partner.
- Using the machine on which you want to install, download the ZIP file that contains the media from the ptc.com/support page, using the download manager option.
Opening the Media Files

Make sure you have at least 50 GB of available space on the server machine, and designate a location for the media files. Depending on whether you obtained the media on a flash drive or in a ZIP file, use one of the following methods to open the media files:

<table>
<thead>
<tr>
<th>Flash Drive</th>
<th>ZIP File</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Insert the flash drive into the USB port of the machine on which you want to install.</td>
<td></td>
</tr>
<tr>
<td>2. In a Windows Explorer window, open the contents of the flash drive.</td>
<td>1. In a Windows Explorer window, navigate to the designated location with at least 50 GB of available space and create a folder for the media files.</td>
</tr>
</tbody>
</table>

💡 Tip
If your USB adapter is slow, it may ultimately save you time to copy the media folder to the designated location with at least 50 GB of available space. This may take an hour or more.

💡 Tip
Use a meaningful folder name, such as “Windchill PDM Essentials Installer.”

2. Be sure you have a ZIP utility that can unzip/unarchive a ZIP file in WinZip format, for example 7–Zip or WinZip.

💡 Tip
To download either 7–Zip or WinZip:

- Go to [http://www.7-zip.org/](http://www.7-zip.org/), and then download and install the 7–Zip utility.

  OR

- Go to [http://winzip.todownload.com/](http://winzip.todownload.com/) and then download and install the WinZip utility.

3. Locate the downloaded ZIP file, and then right-click and select [Your ZIP Utility] ➤ Extract Here.
1. After opening the media files, right-click the application file (not the CONFIG File) **WindchillSetup** and then select **Run as administrator**.

## Caution

Do not select **WindchillSetup.exe.config**, make sure the file type is Application.

A **User Account Control** window appears asking if you want to allow the program to make changes. Click **Yes**.

4. Browse to the location of the folder you created, and then click **OK**.

**Note**

Extraction may take between 5 and 15 minutes depending on the speed of your system.
The Windchill Installation Assistant opens on the Introduction page.

To continue, click Next.

2. On the Agreement page, read the license agreement, select I accept the license agreement, and then click Next.
3. On the **Options** page, if you have an existing instance of PTC Windchill PDM Essentials and are upgrading to a new release, select **Installation for Upgrade**, specify the location of your existing instance, and then click **Next**. Otherwise, select **New Installation** and click **Next**.

For more information about upgrading, see **Upgrading to a New Release of PTC Windchill PDM Essentials on page 134**

4. On the **Validation** page, the installer checks your environment to ensure that Windchill can be properly deployed. If any system prerequisites are not met, the installer does not continue and you must resolve the issue and restart the installer. For more information, see **Prerequisites on page 11**.
After the validation is successful, the assistant prompts you to click **Next**.

5. On the **Configuration** page, enter information in the following areas and then click **Next**.
### Windchill Components

- **Specify Install Location**—This file path is the default installation location for Windchill. To specify a location other than the default installation location, type the desired location or click **Browse** and select the desired location.

  ![Windchill Components](image)

  **Note**
  The install location folder must be writable.

### File Vault

- **Specify File Vault Location**—This file path location is where all of your CAD and document files are stored. To specify a location other than the default location, type the desired location or click **Browse** and select the desired location. If you are upgrading to a new release, this field includes the file vault location of your existing instance and cannot be changed.

### Windchill Directory Server

- **Specify install location for Windchill.**
- **File Vault**
- **Specify File Vault Location**
- **Windchill Application Server**
- **Base Data Language:**
  - **User Name**
  - **Password**
  - **Confirm Password**

### Windchill Directory Server

- **User Name**—This user name is preset to `cn=Manager` and cannot be changed.
- **Password**
- **Confirm Password**

- **Windchill Application Server**—Type credentials for the Windchill Application Server. This is your initial site administrator account. Make a secure record of this information for future management.

- **Base Data Language**—Select the language you want the system to use when displaying the base data for templates (products, libraries, workflow). For example, if you are installing Windchill on an English server but you want the system to use German language templates, select **German**. The Windchill client browser always uses the browser language preferences for displaying information on the client.

- **User Name**—The default user name is `wcadmin`. Accept this default user name or type a new user name.

- **Password**

- **Confirm Password**

- **Company Information**—The installation assistant populates the company information based on your domain information, if possible. Review the information below and change if necessary.

- **Organization Name**—Your company name. This name is used to identify your organization context in Windchill. The installation assistant auto-fills this field based on your internet domain, change if necessary.

- **Internet Domain Name**—The internet domain name for your organization.

- **Contact Email Address**—The contact email address for your organization. This address receives administrative messages and notifications from the server.

---

**Note**

This address is not the address from which users receive Windchill notifications. That address is specified on the next page, see step 5.

---

**Note**

The organization you specify is intended to represent your company and to contain and organize the data for your company employees. For use within a single company, it is best not to create multiple organizations as this will increase the complexity of managing and understanding the system.
6. On the second **Configuration** page, enter information in the following areas, and then click **Next**.

![Configuration page screenshot]

**Note**

If you are upgrading to a new release, some of the information on this page is auto-filled and may not be edited.

- **SQL Server**—Specify an installation location and credentials for the SQL Server. Make a secure record of this information for future management.
  - **Specify Install Location**—To specify a location other than the default location, type the desired location or click **Browse** and select the desired location.
  - **User Name**—The SQL Server user name is preset to **sa** and cannot be changed.
  - **Password**
  - **Confirm Password**

- **Creo Publisher License Server**—The following license server information is used by Windchill for publishing functionality such as automatically generated 3-D formats for use with Creo View.
  - Specify one of the following license server options.
    - **Don't Install**—Select this option to not install the publisher.
- **Single License Server**—Select this option if you only have one license server. This is the default.
- **Triad License Server**—Select this option if you have backup license servers.
  - **License Server**—Type information in one or both of the below license server fields. The system will attempt to communicate with the license server host you specify.
  - **HostName**
  - **Port**

**Note**

A notification appears if the system is unable to reach the server over the port provided. Review your license server host name and port to ensure it is correct before proceeding.

- **Email Configuration**—Email server information is used for delivering email notifications to your email server, such as Windchill event subscriptions. This functionality is optional. To set up email notifications, enter information in the following fields:
  - **SMTP Host**
  - **SMTP Port**
  - **From Address**—This address is the address the email notifications are identified as being “from” when delivered. This field must use a valid email format: `<address>@domain.com`

**Tip**

Use an address that is easily recognizable as being a Windchill notification, such as “Windchill@yourdomain.com.”

- **SMTP User Name**
- **SMTP User Password**

7. On the **Review** page, review your configuration to ensure everything is correct. To make corrections to a previous page, click **Back**. After you have reviewed the configuration options and verified that they are correct, click **Install**.
The installation time is estimated between 1–3 hours; it need not be monitored. During installation, the installer displays the progress of each component.

![Installation progress](image)

The log file from the **Windchill Installation Assistant** can be found at the following location, where `<PDMEssentials_Media>` is the location where you opened the PTC Windchill PDM Essentials media files and started the WindchillSetup application file: `<PDMEssentials_Media>\WC_PDMEssentials.01\logs\SuperInstaller.log`. For more information, see Opening the Media Files on page 33.

8. After all components have been successfully installed, click **Finish**.

The **Windchill Installation Assistant** closes and a **Windows Security** window appears, requesting credentials for the server on which the installation has been completed.
9. Type the **Windchill Application Server** user name and password specified on the second **Configuration** page, and then click **OK**.

💡 **Tip**

Unless you specified a new user name, the default is `wcadmin`. 
The Windchill Setup Assistant Launcher page opens in your default browser indicating you have successfully installed the Windchill solution.

**Note**
If Internet Explorer blocks the **Windchill Setup Assistant Launcher** page, add it to the list of trusted sites.

The Windchill Setup Assistant launches automatically. If the **Windchill Setup Assistant** does not launch after about a minute, click the **Click here if assistant does not appear** link to manually launch it.

**Note**
Even after the **Windchill Setup Assistant** launches, do not close the **Windchill Setup Assistant Launcher** page. After the **Windchill Setup Assistant** is completed, this page automatically launches the Windchill Home page. If the **Windchill Setup Assistant Launcher** page is closed, however, you can still open the Windchill Home page from your browser favorites or a shortcut on the desktop after the **Windchill Setup Assistant** is completed.
Configuring Windchill

After the installation assistant is finished installing Windchill, the system is ready for configuration. PTC Windchill PDM Essentials includes a convenient Windchill Setup Assistant that streamlines and simplifies several configuration steps and automates parts of the configuration process.

Using the Windchill Setup Assistant

After completing the PTC Windchill PDM Essentials installation, the Windchill Setup Assistant opens in a browser window. It may take up to a minute to completely load and render this initial page.

💡 Tip

This documentation is available from the Help Center at any time by clicking the help button 📚. For more information, see Using the Windchill Help Center on page 149.
This Windchill Setup Assistant is organized into five pages, described below. Your progress through these pages is indicated at the top.

The current page number is orange, completed or skipped page numbers are green, and pages not yet completed have gray numbers.

Each page is optional, use the Back and Next buttons to go to applicable pages, or click the step number. Click Finish at any time to complete the Windchill Setup Assistant.

⚠️ Caution

After clicking Finish and closing the Windchill Setup Assistant, you cannot access it again. Be sure you complete all of the configuration options that are applicable to your organization before completing the Windchill Setup Assistant.

1. Number Scheme on page 47—Use the Number Scheme page to enable and configure a number scheme to use for automatically generating numbers for new CAD documents. The default setting is to prompt users to manually enter identifying numbers for CAD documents.

2. Publishing on page 48—Enable server-side publishing and automatically generate thumbnails and 3–D viewable images that are accessible from CAD documents. Specify publishing filters to define what file types are published. This configuration option is only available if you selected the option to install Creo Parametric publishing.

3. Version Scheme on page 49—Select a scheme to use for file version management.

4. Participants on page 49—Add users as participants and select the team roles to which they belong.

5. Attributes on page 53—Add attributes to make available for CAD documents (for example, part, assembly, and drawing files). Attributes are visible and modifiable from within the CAD application.
Number Scheme

Numbering schemes control how numbers are generated for baselines, documents, CAD documents, and dynamic documents. You can configure Windchill either to prompt the user to manually enter numbers or to automatically generate numbers using a defined scheme.

- **Generate Numbers manually**
- **Generate Numbers automatically using standard scheme**

Select one of the following options:

- **Enter Numbers manually**—Select this option if you want users to manually specify a number for each new CAD document. For example, if you get new part numbers from an ERP or MRP system, from another part number generator, or if you manage a list of numbers in a spreadsheet.

  - **Note**
    
    CAD document file names and numbers must be unique across the system, this uniqueness is enforced by Windchill.

- **Generate Numbers automatically using standard scheme**—Define the scheme you want all generated numbers to have using the following optional fields:
  
  - **Number Of Digits**—Select the number of digits for the number scheme. Windchill pads with zeros. For example, the number one using a six digit number scheme appears as 000001.
  
  - **Prefix**—Type a prefix. Each number begins with this prefix. For example, the number one using a prefix of PTC and a number of six digits appears as PTC000001. The prefix must use the following characters: alphanumeric (A–Z, a–z, 0–9), hyphen(-), or underscore(_).
  
  - **Separator**—Type a character to use as the separator between the prefix and number. For example, the number one using a prefix of PTC, a number of six digits, and a separator of a dash appears as PTC-000001.
Base Number—Type the number you want to use as the number on which to begin incrementing. For example, the first number that is assigned if the numbering scheme uses six digits, a prefix of PTC, a separator of a dash, and a base number of 000101 is PTC-000101.

Separator—Type a character to use as the separator between the number and the suffix. For example, the number one using a prefix of PTC, a number of six digits, a separator of a dash between the prefix and the number, a separator of an asterisk between the number and the suffix, and a suffix of CAD is PTC-000001*CAD.

Suffix—Type a suffix. Each number ends with this suffix. For example, the number one using a prefix of PTC, a number of six digits, a separator of a dash between the prefix and the number, a separator of an asterisk between the number and the suffix, and a suffix of CAD is PTC-000001*CAD. The suffix use the following characters: alphanumeric (A-Z, a-z, 0–9), hyphen (-), or underscore(_).

For more information about object numbers, see the Object Numbering Help Center topic.

For more information about number schemes, see the Creating Numbering Scheme Rule Content Help Center topic.

Publishing

On the Publishing page, specify whether or not you want server-side publishing to be enabled and select any applicable publishing filters. Server-side publishing automatically generates thumbnails and 3–D viewable images that are accessible from CAD documents.

- Enable Publishing—Enables server-side publishing for parts, drawings, and assemblies for Creo View using the PVS format. Clear this checkbox to disable server-side publishing.

Note

If you choose not to enable server-side publishing, viewable images are created client-side during custom Creo Parametric checkin.
• **Select types to publish**—For Creo Parametric, select the file types for which to generate 3–D viewable images and thumbnails. File types that are not selected are not published at all. This is used to manage server load.
  
  ○ Creo Part  
  ○ Creo Assembly  
  ○ Creo Drawing

For more information, see the [Visualizing Parts and CAD Documents](#) help Center topic.

**Version Scheme**

On the **Version Scheme** page, select a version numbering scheme from the list that you would like to use when revising version-controlled items.

The version scheme must be configured before creating data that uses the scheme.

<table>
<thead>
<tr>
<th>Version Scheme</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>ASME Y 14.35</td>
<td></td>
</tr>
<tr>
<td>Simple Letter (A1, B1, C1...)</td>
<td></td>
</tr>
<tr>
<td>Simple Number (1.1, 2.1, 3.1...)</td>
<td></td>
</tr>
</tbody>
</table>

**Tip**

The ASME version scheme adheres to the standards of the American Society of Mechanical Engineers.

For more information, see the [Object Versioning](#) Help Center topic.

**Participants**

The **Participants** page is used to add users to predefined profiles and team role groups. These groups are associated with permissions for Windchill information and actions at various steps of the life cycle.

**Note**

It is a best practice to add at least one user to each predefined role/group. A user can be added to multiple roles/groups.
To add a participant:

1. Click the create new user icon.

2. In the **User Attributes** section, enter information for the new user. An asterisk (*) indicates a required field.

   ![User Attributes section](image)

   - **First Name**: Mark
   - **Last Name**: Manager
   - **User Name**: manager
   - **Email Address**: manager@ptc.com
   - **Organization**: PTC

3. In the **Role/Group Membership** section, select one of the following groups from the Assign Group list of predefined team roles, and then click **OK**.

---

**Note**

The default password for the added user is the same as the **User Name** specified here. You can change users passwords or inform users to change their password when they first log on.

For information on how to change user passwords from the Participant Administration utility, see the **Changing User Passwords** Help Center topic.

When instructing users to change their own password, refer them to the following Help Center topic: **Changing Your Password**.

---

3. In the **Role/Group Membership** section, select one of the following groups from the **Assign Group** list of predefined team roles, and then click **OK**.
• **Administrator**—Also referred to as the Organization Administrator, users associated with this profile have visibility to administer the system and the ability to create, update, and delete all objects at the organization level.

**Note**
This administrator (Organization Administrator) is not the same as the site administrator (wcadmin), who manages the site context and is specified in the installation assistant. However, the same user may be created as Site Administrator (wcadmin) in the Windchill Installation Assistant and assigned to the Administrator role (Organization Administrator) in the Windchill Setup Assistant.

• **Manager**—Users associated with this profile can perform the following actions:
  ○ Product Management—Create and manage products and content within a product, including changing the state of an object (to release it, for example).
  ○ Library Management—Create and manage libraries and content within a library, including changing the state of an object (to release it, for example).
  ○ Promotion Requests Management—Initiate and approve promotion requests.
  ○ Document Management—Manage CAD documents and view, create, and edit non-CAD documents.
  ○ Organization Administration—Perform organization administration tasks, such as adding and managing organization users.

  For more information about administrative tasks, see Moving Forward: Ongoing Windchill Administration on page 101.

• **CAD Author**—Users associated with this profile can view, create, and edit CAD documents in products and can view CAD documents in libraries.

• **Contributor**—Users associated with this profile can create and edit
documents and can view CAD documents that are in the released state. These members can also view and markup 3-D viewable images associated with CAD documents.

- **Viewer**—Users associated with this profile can view documents and CAD documents that are in the Released state.

---

**Note**

You can only select one role/group for the current user. If you want to add this user to more than one role/group, follow the above steps for each role/group. For example, if you want to add a user to the CAD Author and the Contributor groups, you must add that user to the participants list twice, once for each intended group.

For more information about the available roles and groups, see Participants on page 58.

---

**Note**

The **Manager** group is automatically added to the **Product Creators** group and the **Library Creators** group. Other than Organization Administrators, only members of these groups can create products and libraries, respectively.

Each added user appears in the participants list.

<table>
<thead>
<tr>
<th>Full Name</th>
<th>User Name</th>
<th>Email Address</th>
<th>Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>admin</td>
<td>admin</td>
<td><a href="mailto:pthute@ptc.com">pthute@ptc.com</a></td>
<td>Administrator</td>
</tr>
<tr>
<td>manager</td>
<td>manager</td>
<td><a href="mailto:pthute@ptc.com">pthute@ptc.com</a></td>
<td>Manager</td>
</tr>
<tr>
<td>cadauth</td>
<td>cadauth</td>
<td><a href="mailto:pthute@ptc.com">pthute@ptc.com</a></td>
<td>CAD Author</td>
</tr>
<tr>
<td>contri</td>
<td>contri</td>
<td><a href="mailto:pthute@ptc.com">pthute@ptc.com</a></td>
<td>Contributor</td>
</tr>
<tr>
<td>viewer</td>
<td>viewer</td>
<td><a href="mailto:pthute@ptc.com">pthute@ptc.com</a></td>
<td>Viewer</td>
</tr>
</tbody>
</table>

To remove users from the list, select the checkbox in front of each user and click the remove selected objects icon 🗑️.

To edit information for a user in the list, select the checkbox in front of the user and click the edit objects icon ✍️.
When all users are added, click Next to continue.

For more information, see the Creating a New User Help Center topic.

Attributes

The Attributes page is used to specify custom attributes that you want to associate with CAD models such as parts, assemblies, and drawings. These attributes are created as Windchill global attributes. These Windchill attributes are associated with parameters in Creo Parametric if the Windchill attribute Internal Name and the attribute type matches the CAD parameter name and type, and if the CAD parameter is “designated.” If this association is in place the parameter or attribute values are automatically exchanged between the server and CAD file.

For more information, see the Mapping Creo Parametric Parameters to Windchill Attributes and About Attribute Mapping Help Center topics.

Commonly displayed Windchill attributes for CAD documents include those in the following table.

These attributes are included in Windchill, use the Attributes page of the Windchill Setup Assistant to create additional attributes for your CAD documents.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The number of the CAD document</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the CAD document</td>
</tr>
<tr>
<td>File Name</td>
<td>The CAD file name that is the primary content of the CAD document</td>
</tr>
<tr>
<td>Version</td>
<td>The revision and iteration of the CAD document</td>
</tr>
<tr>
<td>State</td>
<td>The life cycle state of the CAD document</td>
</tr>
<tr>
<td>Last Modified</td>
<td>The date and time that the CAD document master was most recently modified</td>
</tr>
<tr>
<td>Modified By</td>
<td>The name of the user that last modified the CAD document master</td>
</tr>
<tr>
<td>Description</td>
<td>The description note on the CAD document iteration</td>
</tr>
<tr>
<td>Type</td>
<td>If the CAD document is a subtype, displays the &quot;Display Name&quot; of the subtype</td>
</tr>
<tr>
<td>Document Category</td>
<td>The category and subcategory of the primary content of the CAD document</td>
</tr>
<tr>
<td>Location</td>
<td>The current database storage location (context and folder) of the CAD document</td>
</tr>
<tr>
<td>Attribute</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Created On</td>
<td>The date and time that the CAD document master was created</td>
</tr>
<tr>
<td>Created By</td>
<td>The name of the user that created the CAD document master</td>
</tr>
<tr>
<td>Authoring Application</td>
<td>The CAD tool in which the CAD file was created</td>
</tr>
<tr>
<td>Missing Dependents</td>
<td>Indicates whether all dependents of the CAD document were checked in or not. (Value: True or False)</td>
</tr>
<tr>
<td>Generic</td>
<td>Will be true if the object is generic of a family table</td>
</tr>
<tr>
<td>Instance</td>
<td>Will be true if the object is instance of a family table</td>
</tr>
<tr>
<td>Incomplete Object</td>
<td>Will be true if the object is a ‘ghost’ object (that is, has incomplete dependencies)</td>
</tr>
<tr>
<td>Document Subcategory</td>
<td>Indicates the subcategory of the CAD document</td>
</tr>
<tr>
<td>Checkin Comments</td>
<td>Displays the check-in comment of the iteration</td>
</tr>
<tr>
<td>Context</td>
<td>Indicates in which context the object resides</td>
</tr>
<tr>
<td>Life Cycle Template</td>
<td>Indicates the life cycle template being used for the CAD document</td>
</tr>
</tbody>
</table>

To add an attribute:
1. Click the add attribute to list icon.
The **Add/Edit Attributes** page opens in a new window.

![Add/Edit Attributes page](image)

2. In the **Attributes** section, enter information into the following fields:

   - **Display Name**—Type the attribute name you want to be displayed in attribute lists. The attribute name cannot begin with “PTC_” (for example, “PTC_NetWeight”), and the name cannot contain special characters (characters that are not alpha-numeric) except hyphens and underscores, which are allowed.

   - **Internal Name**—This name is automatically generated based on the **Display Name** and is the string you should use to create and designate matching CAD file parameters in Creo Parametric.

   - **Type**—Select one of the following attributes from the list. The value selected in this list determines which attribute fields are available.

     - **Boolean**—True/False (Yes/No)
     - **Integer Number**—Integer number (no decimal)
     - **Real Number**—Decimal number
     - **Real Number with Units**—Decimal number with units
     - **String**—Text

   - **Units Of Measure**—For an attribute type of **Real Number with Units**, select the units indicating the quantity of measure you want the numeric attribute to represent.

   - **Description**—Type an attribute description.
• **Minimum Value**—For an attribute type of **Integer Number**, **Real Number**, or **Real Number with Units**, type a minimum possible numeric value. This field, along with **Maximum Value**, defines a range of valid numeric values. This range is inclusive, meaning the minimum and maximum values are allowed as well as the numeric values between.

• **Maximum Value**—For an attribute type of **Integer Number**, **Real Number**, or **Real Number with Units**, type a maximum possible numeric value. This field, along with **Minimum Value**, defines a range of valid numeric values. This range is inclusive, meaning the minimum and maximum values are allowed as well as the numeric values between.

• **Default Value**—Type a default value for the attribute. Characters allowed are defined by the attribute type:
  - **Integer Number**—Numeric values allowed.
  - **Real Number**—Decimal values allowed.
  - **Real Number with Units**—Characters allowed are the same as the **Real Number** attribute type.
  - **String**—All characters are allowed.

• **Boolean Default Value**—For an attribute type of **Boolean**, select whether you want the default value to be Yes, No, or blank (no default value).

Each added attribute appears in the attributes list.

To remove attributes from the list, select the checkbox in front of each attribute and click the remove selected objects icon.

To edit information for an attribute in the list, select the checkbox in front of the attribute and click the edit objects icon.

When all attributes are added, click **Next** to continue.

For more information on the attributes added by the **Windchill Setup Assistant**, see **Attributes** on page 69.
Completing the Windchill Setup Assistant

After your configuration selections are complete, click **Finish**.

⚠️ **Caution**

Make sure you have specified all of the configuration settings you need before clicking **Finish**, the Windchill Setup Assistant cannot be opened again.

The configuration specifications are applied and the Windchill server restarts. This may take several minutes.

When the configurations have been successfully applied:

- The Windchill **Home** page opens in your default browser.

💡 **Tip**

On the Windchill **Home** page, the browser address bar contains the server name and location; everything before “/app/” in the address. For example, `http://servername.ptcnet.ptc.com/Windchill`. Email this address to each user; it is used when they set up integration between Windchill and their CAD application. For more information, see Integrating with Your CAD Application on page 73.

- A shortcut to the Windchill **Home** page is created on the server desktop.
- A link to the Windchill **Home** page is created in the bookmarks or favorites of your default browser.
- A Windchill Windows service is created so that when the server machine is rebooted, all of the Windchill components automatically start in the proper sequence. For more information, see Restarting the Windchill Windows Service on page 120.

**Additional Configuration Steps for Autodesk Inventor and SolidWorks**

PTC Windchill PDM Essentials is configured with the Creo Parametric CAD worker installed on the same machine as Windchill.

If you wish to publish formats for Autodesk Inventor or SolidWorks, you must purchase the CAD adapter for these applications and configure a CAD worker on a separate physical or virtual machine because Autodesk Inventor and SolidWorks do not support installation into a Windows Server operating system.

For more information, see Configuring a Remote CAD Worker for Autodesk Inventor and SolidWorks on page 110.
Understanding the Automated Configuration

PTC Windchill PDM Essentials automatically configures Windchill for convenient, immediate production for basic CAD data management. This section briefly describes these configurations to help you get started in your new environment. The following configurations are covered:

- Participants on page 58
- Library Template on page 63
- Product Template on page 64
- Policy Administration and Access Control Rules on page 66
- CAD Data Management Life Cycle on page 67
- Attributes on page 69
- Publish Rules on page 70

Participants

Windchill uses the term participant to mean a user, group, or organization. The PTC Windchill PDM Essentials configuration defines the following ways to organize participants:

- Organization Groups—PTC Windchill PDM Essentials includes five out-of-the-box organization groups. Users are added to one or more of these groups as part of the Windchill Setup Assistant:
  - Administrator
  - Manager
  - CAD Author
  - Contributor
Note

The **Manager** group is automatically added to the **Product Creators** group and the **Library Creators** group. Other than Organization Administrators, only members of these groups can create products and libraries, respectively.
These groups define user configurations for profiles, shared teams, and roles. New users should always be added to one or more of these groups.

- **Profiles**—A profile controls what information and actions are visible to the user or group associated with the profile. Each organization group (with the exception of Administrator) is associated with a corresponding profile of the same name.

A description of each profile follows:

- **Manager**—Users associated with this profile can perform the following actions:
  - Product Management—Create and manage products and content within a product, including changing the state of an object (to release it, for example).
  - Library Management—Create and manage libraries and content within a library, including changing the state of an object (to release it, for example).
  - Promotion Requests Management—Initiate and approve promotion requests.
  - Document Management—Manage CAD documents and view, create, and edit non-CAD documents.
• Organization Administration—Perform organization administration tasks, such as adding and managing organization users.

For more information about administrative tasks, see Moving Forward: Ongoing Windchill Administration on page 101.

○ CAD Author—Users associated with this profile can view, create, and edit CAD documents in products and can view CAD documents in libraries.

○ Contributor—Users associated with this profile can create and edit documents and can view CAD documents that are in the released state. These members can also view and markup 3–D viewable images associated with CAD documents.

○ Viewer—Users associated with this profile can view documents and CAD documents that are in the Released state.

For more information, see the Profiles Help Center topic.

• Shared Teams—PTC Windchill PDM Essentials includes the following shared teams:

○ Library Team—Automatically associated with all libraries created with the Team Library template.

For more information, see Library Template on page 63.

○ Product Team—Automatically associated with all products created with the Team Product template.

For more information, see Product Template on page 64.

For more information about teams, see the Teams Help Center topic.
For more information about shared teams, see the About Shared Teams Help Center topic.

- **Roles**—A role relates members in the context to information and activities managed in that context. The PTC Windchill PDM Essentials out-of-the-box shared teams automatically include roles that correspond to the out-of-the-box organization groups. Each organization group, along with all of its members, is automatically included in the corresponding shared team role:

  ![Diagram of Organization Groups and Shared Team Roles]

  - **Manager Group** maps to the **Manager Role**
  - **CAD Author Group** maps to the **CAD Author Role**
  - **Contributor Group** maps to the **Contributor Role**
  - **Viewer Group** maps to the **Viewer Role**

**Note**

The **Administrator** group is not included in the shared teams because members of that group administer the system rather than viewing and managing data.
For more information, see the About Roles and Groups Help Center topic.

Library Template

A predefined library template named **Team Library** is automatically created and configured as follows:

- A **Shared Team** called **Library Team** is automatically associated with libraries created using the **Team Library** template.

  ![Library Team Shared Team](image)

  - Roles—The **Library Team** includes all of the predefined role groups listed in the **Windchill Setup Assistant**, except **Administrator**. All roles except for **Manager** have read-only access to the released content of the parts library and only a user in the **Manager** role is allowed to create objects in the library. Users added to an organization group are automatically added to the associated library role for any libraries that were created using the **Team Library** template.

    For more information about the predefined role groups, see Participants on page 58.
Permissions for libraries created with the **Team Library** template are defined by predefined access control rules. For more information, see *Policy Administration and Access Control Rules on page 66.*

Using the **Team Library** template, a library named **Parts Catalog** is automatically created during the PTC Windchill PDM Essentials installation with all of the above configurations.

For more information about libraries, see the **About Libraries** Help Center topic. For more information about library administration, see the **Working with Products and Libraries** Help Center topic.

**Product Template**

A predefined product template named **Team Product** is automatically created and configured as follows:
• A **Shared Team** called **Product Team** is automatically associated with products created using the **Team Product** template.

  ○ Roles—The **Product Team** includes all of the predefined role groups listed in the **Windchill Setup Assistant**, except **Administrator**. Users added to an organization group are automatically added to the associated product roles for any existing products that were created using the **Team Product** template.

    For more information about the predefined role groups, see **Participants on page 58**.

    Permissions for products created with the **Team Product** template (including permissions to life cycle states of CAD documents) are defined by predefined access control rules. For more information, see **Policy Administration and Access Control Rules on page 66**.

    For more information about products, see the **About Products** Help Center topic.

    For more information about product administration, see the **Working with Products and Libraries** Help Center topic.
Policy Administration and Access Control Rules

Access control rules are predefined for the following domains as children of the parent Organization domain:

- **Library Team**—Defines the access control rules for the Parts Catalog library and any other library created from the Team Library template. These access control rules specify the permissions of participants based on the team role to which they are assigned.

- **Product Team**—Defines the access control rules for products created from the Team Product template. These access control rules specify the permissions of participants based on the team role to which they are assigned. Among the permissions defined, access control rules are specified for the life cycle states of CAD documents.

For details about CAD document life cycle states and participant permissions, see CAD Data Management Life Cycle on page 67.
For more information about the Parts Catalog library and the Team Library context, see Library Template on page 63.

For more information about the Team Product template, see Product Template on page 64.

For more information about team roles, participant, and organization groups, see Participants on page 58.

For details about Policy Administration and Access Control Rules, see the Policy Administration Help Center topic.

**CAD Data Management Life Cycle**

A basic life cycle called CAD Data Management is predefined during the configuration and associated with user roles and groups through access control rules. The CAD Data Management life cycle is automatically associated with all documents and CAD documents.

![CAD Data Management Life Cycle](image)

**Note**

Although there are other standard Windchill life cycle templates visible in the Templates table for an organization and in the Life Cycle Template Administration utility, as a best practice, use the CAD Data Management life cycle template that is configured to be automatically associated with all documents and CAD documents.
The **CAD Data Management** life cycle controls access based on role and current life cycle state of the document.

The following table describes the access behavior for a document or CAD document that is created with the **CAD Data Management** life cycle:

<table>
<thead>
<tr>
<th>Roles/States</th>
<th>In Work</th>
<th>Under Review</th>
<th>Preproduction</th>
<th>Released</th>
<th>Obsolete</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewer</td>
<td>No Access</td>
<td>No Access</td>
<td>No Access</td>
<td>Read</td>
<td>No Access</td>
</tr>
<tr>
<td>Contributor</td>
<td>No access</td>
<td>Read</td>
<td>Read</td>
<td>Read</td>
<td>No Access</td>
</tr>
<tr>
<td>CAD Author</td>
<td>Full control</td>
<td>Full Control</td>
<td>Full Control</td>
<td>Read, Revise, Move</td>
<td>Read</td>
</tr>
<tr>
<td>Manager</td>
<td>Full control</td>
<td>Full Control</td>
<td>Full Control</td>
<td>Full Control</td>
<td>Full Control</td>
</tr>
<tr>
<td>Administrator (Organization)</td>
<td>Full control</td>
<td>Full Control</td>
<td>Full Control</td>
<td>Full Control</td>
<td>Full Control</td>
</tr>
</tbody>
</table>

For more information, see the [About Life Cycles Help Center topic](#).
Attributes

Custom CAD document attributes that were created in the **Windchill Setup Assistant** can be viewed by site or organization administrators in Windchill using the **Type and Attribute Management** utility, accessed by clicking the **Type and Attribute Management** link from **Site ▶▶ Utilities** or **Organizations ▶▶ Utilities**. Under **Manage Types**, navigate to **EPM Document ▶▶ CAD Document**.

For more information, see the **Working with the Type and Attribute Management Utility** Help Center topic.

Custom CAD document attributes created in the **Windchill Setup Assistant** are defined as global attributes and collected under the **defaultEPMOrganizer** set. To view and edit the global attributes in the **Type and Attribute Management** utility, click the **Manage Global Attributes** icon and navigate to **defaultEPMOrganizer**.

For more information, see the **Managing Global Attributes** Help Center topic.
Publish Rules

Default Publish Rules are configured to automatically generate formats typically needed in manufacturing and procurement whenever a Creo Parametric CAD model is released. These Publish Rules also enable users to manually generate formats for specific Creo Parametric CAD models as needed. The default Publish Rules are configured as follows:

<table>
<thead>
<tr>
<th><strong>Action</strong></th>
<th><strong>Behavior</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Check In</strong></td>
<td>When a Creo Parametric CAD document is checked into Windchill, a thumbnail and representation is generated.</td>
</tr>
</tbody>
</table>
| Life cycle state change | When the life cycle state of a Creo Parametric CAD document is changed to Released in Windchill, the following Publish Rules behavior applies:  
  • A thumbnail and representation is generated.  
  • For Creo Parametric parts (.prt) and assemblies (.asm), the following formats are generated:  
    ○ IGES  
    ○ STEP  
  • For Creo Parametric drawings (.drw), the following formats are generated:  
    ○ PDF  
    ○ DXF |
### Action Behavior

<table>
<thead>
<tr>
<th>Action</th>
<th>Behavior</th>
</tr>
</thead>
</table>
| **New Representation**  | At any time, the **New Representation** action can be selected to generate a representation for a Creo Parametric CAD document. When **New Representation** is selected, the following Publish Rules behavior applies:  
  - For Creo Parametric parts (.prt) and assemblies (.asm), any one or more of the following formats can be manually generated:  
    - IGES  
    - STEP  
    - PDF  
  - For Creo Parametric drawings (.drw), any one or more of the following formats can be manually generated:  
    - PDF  
    - DXF  
    - IGES  
    - STEP  
    - DWG  
    - CGM |
| **Scheduled Publish Job** | If a publish job is scheduled, the following Publish Rules behavior applies for objects in a released state when the scheduled job executes:  
  - For Creo Parametric parts (.prt) and assemblies (.asm), the following formats are generated:  
    - IGES  
    - STEP  
  - For Creo Parametric drawings (.drw), the following formats are generated: |
### Action Behavior

<table>
<thead>
<tr>
<th>Action</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- PDF</td>
</tr>
<tr>
<td></td>
<td>- DXF</td>
</tr>
</tbody>
</table>

**Note**

Publish jobs are not automatically scheduled in this configuration. For more information about setting up scheduled publish jobs, see the **WVS Job Scheduler Administration** Help Center topic.

Editing these default Publish Rules requires you to manage the Publish Rules XML file located in the following subdirectory of your installation location:

Windchill\loadFiles\smb\PublishRulesForEssentials.xml.

The following Windchill Visualization Service properties are set as part of the default Publish Rules configuration:

- publish.usesPublishRules="ARBOR TEXT PROE"
- publish.republishonepmdocumentchange=true
- publish.publishonepmdocumentchange=true

For more information about managing Publish Rules, see the **Using Publish Rules** Help Center topic.
After you have successfully installed and configured the Windchill server, you can set up the integration with your CAD application on client workstations. This section provides you with the information you need to get set up and working with Creo Parametric, Creo Direct, and Creo Elements.

For information about installing a Windchill Workgroup Manager and setting up integration between Windchill and a third-party CAD application (such as for AutoCAD, Autodesk Inventor, or SolidWorks), see Installing Windchill Workgroup Manager for a Third-Party CAD Application on page 99.
Working with Creo Parametric

This section provides basic information on the administrative and CAD user tasks necessary to integrate Windchill and Creo Parametric.

Administrator Initial Setup

Before users can start using Windchill, an initial setup must be performed to configure certain business processes and to establish a seamless data exchange between Creo Parametric and Windchill. The next sections describe necessary configurations performed by an administrator.

Configuring an Attribute Exchange Between Windchill and Creo Parametric

You must map the attributes and parameters of Creo Parametric to Windchill attributes. This mapping ensures that attributes and parameters are propagated and properly updated in both Windchill and Creo Parametric.

Note

Windchill attributes were created during the PTC Windchill PDM Essentials installation, using the Windchill Setup Assistant. For more information, see Attributes on page 53.

For more information, see the Mapping Creo Parametric Parameters to Windchill Attributes and About Attribute Mapping Help Center topics.

In addition, you may need to manage system attributes and parameters, and customize out-of-the-box Windchill attributes, or those you created during the installation of PTC Windchill PDM Essentials, to create the necessary additional CAD attributes.

For information about managing Windchill global attributes, see the Managing Global Attributes section of the PTC Windchill Help Center.

Using CAD Document Templates

When the data in Creo Parametric is managed by Windchill, you must select a CAD document template used by Windchill to create a new object. A CAD document template determines the attributes that you need to specify when creating a new CAD document.

CAD document templates are created and managed from the Templates pages in Windchill, which are accessible only to administrators. The CAD document templates can be created in the context of a product, library, project, program, organization, or site.
Both Windchill and Creo Parametric use default template files when creating a new object. In Creo Parametric these objects are called start parts and in Windchill they are referred to as CAD document templates. Creo Parametric start parts can be managed in Windchill so that both applications use the same set of template files. For more information, see CAD Document Templates and Creo Parametric Start Parts on page 98.

Creating a Repository for Your Data

Before users start working on a new design, you typically create a new product or library in Windchill to manage the new product’s data. Within this product, users can then set up a workspace to work on their portion of the design.

To learn about creating a new product or library, see the Working with Products and Libraries Help Center topic.

Enabling Workspaces

By default, the workspace may not be listed in the Windchill navigation pane in the embedded browser or in a standalone Windchill window. To display the workspace link in the navigation pane, set the preference Workspace to yes using the Windchill Preference Management utility.

For more information, see the Displaying the Workspace Help Center topics.

Noting the Server Name and Location

In order for users to work with Windchill, they must register a Windchill server and select an active workspace on that server. On the Windchill Home page, the browser address bar contains the server name and location; everything before “/app/” in the address. For example, http://servername.ptcnet.ptc.com/Windchill. Email this server address to each CAD user.

Creo Parametric Parameters and Windchill Attributes

During the Windchill Setup Assistant for PTC Windchill PDM Essentials, Windchill custom attributes were specified to be associated with CAD models. Additional Creo Parametric designated parameters can be mapped to Windchill attributes. Attribute mapping transfers parametric information from the CAD models created in Creo Parametric to the Windchill system.

For more information, see the Mapping Creo Parametric Parameters to Windchill Attributes Help Center topic.
Other Considerations

This topic provides additional considerations for setting up the integration of Creo Parametric and Windchill.

Configuring Object Collections

The collection process determines how an object’s dependents are collected when the object is selected for a data management operation, for example, Check In. An administrator or a user can define the default collector behavior using the Preference Management utility.

For more information, see the About the Collector and Configuring the Initial Collection of Objects for Actions Help Center topics.

Configuring Revisions

An administrator can configure the sequence of steps in the revision process by using the Initial Revision Parameter preference in the Windchill Preference Management utility.

For more information, see the Administering Revision Help Center topic.

Suggestions for Further Reading

Your primary resource for information on Windchill processes and functions is the Windchill Help Center, which you can access from the embedded browser or from standalone Windchill browser. Once Windchill is installed, launch the Windchill Help Center by clicking one of the following:

- Quick Links menu in the upper-right corner of the Windchill screen
- Help buttons throughout the user interface

Note

The Windchill Help Center is also available on https://www.ptc.com/appserver/cs/help/help.jsp.

For more topics regarding the administration of the integration between Creo Parametric and Windchill, refer to the Configuring Windchill for Interoperation with Creo Parametric Help Center topic.
When learning about Windchill, you may be interested in the following general administrative topics:

<table>
<thead>
<tr>
<th>Windchill process or functional area</th>
<th>Where to find information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring access control</td>
<td>See the Security Management section of the PTC Windchill Help Center.</td>
</tr>
<tr>
<td>Configuring life cycles</td>
<td>See the Life Cycle Template Administration section of the PTC Windchill Help Center.</td>
</tr>
<tr>
<td>Setting preferences</td>
<td>See the Preference Management section of the PTC Windchill Help Center.</td>
</tr>
<tr>
<td>Creating new subtypes</td>
<td>See the Managing Types section of the PTC Windchill Help Center.</td>
</tr>
<tr>
<td>Using Windchill workflows</td>
<td>See the Workflow Template Administration section of the PTC Windchill Help Center.</td>
</tr>
</tbody>
</table>

**Getting Started for CAD Users**

This chapter provides basic information on how to start working with Windchill and Creo Parametric. The next topics describe a streamlined approach to common data management functions.

For more detailed information about working with Creo Parametric and Windchill, refer to the Getting Started with Creo Parametric section of the PTC Windchill Help Center.

**Connecting to a Windchill Server**

To work with Windchill, you must register a Windchill server and select an active workspace on that server.

**Registering a Server**

1. In Creo Parametric, select Tools ▶️ Server Management; or in the ribbon, select File ▶️ Manage Session ▶️ Server Management. The Server Management window opens. The Servers tab has two sections: the top section lists registered servers, and the bottom section lists the workspaces available on the selected server.
3. Specify the server name to appear in the Folder Browser.
Tip
As a working practice, it is recommended that all users in a company register the server using the same name.

4. Specify the location by entering the URL to the Windchill server. You can get this information from your Windchill administrator.

Tip
On the Windchill Home page, the browser address bar contains the server name and location; everything before “/app/” in the address. For example, http://servername.ptcnet.ptc.com/Windchill.

5. Click Check to validate the server location.
6. Enter the user name and password in the authentication window.
7. Select the active workspace.

Note
If you are setting up your connection for the first time, a default workspace is created in each Windchill product that you have access to. If you are connecting to a previously registered server, you can select from a list of available workspaces. For more information, see Creating and Activating a Workspace on page 85.

8. Click Close.
9. Designate the primary server by right-clicking it in the list and selecting Set as Primary Server (or in the Server Management window, by clicking Server ▶ Set as Primary Server).

Note
Once registered, the active workspace is listed in the Folder Navigator. If desired, you can now create your own workspace on the primary server and set it as active. For more information, see Creating and Activating a Workspace on page 85.
Getting Familiar with the Windchill Embedded Browser

Creo Parametric contains two distinct areas:

- **Navigators** – This pane contains the **Folder, Favorites, History, and Search** navigators.
- **Windchill embedded browser** – This pane allows you to view and access data for the locations selected in the **Folder** navigator, for example, the contents of a workspace or the contents of a folder on a Windchill server.

Note

The Creo Parametric embedded browser is the only browser that supports the connection between your CAD application and a Windchill server. A standalone Internet Explorer or Mozilla browser does not support connectivity between Creo Parametric and Windchill.

Learning About the Windchill User Interface

Once connected to the Windchill server, the embedded browser displays Windchill pages and functions. To learn about the basics of the Windchill user interface, you can review the Windchill Quick Start Guide, accessible from the **Quick Links** menu.
Using Windchill Data Management Actions from Creo Parametric

When Creo Parametric is connected to Windchill, Windchill inserts certain data management actions in your application’s user interface, for example, **Check In** and **Check Out**.

In addition, the behavior of some of the commands in Creo Parametric is changed, such as **Save** or **Open**. For example, when Creo Parametric is connected to Windchill, **Open** and **Save** use the workspace local directory as the default location.

Searching for Existing Data in Windchill

Windchill provides powerful search tools that allow you to locate and retrieve product information of all types.

---

**Note**

Your ability to search for and retrieve information depends upon access control policies implemented at your company. An object can exist in the Windchill database but not appear in your search results because of these policies.

---

The following sections provide an overview of Windchill search functionality. For detailed information, see the **Searching for Information** section of the PTC Windchill Help Center.

**Global Search**

A global search is a keyword search performed against all contexts for which you have access. The global search fields are located in the upper right of the Windchill browser page:

Keep the following search guidelines in mind:

- By default, keywords are only compared against the **Name** and **Number** attribute field values.
- The keyword must match the complete field. For example, if you are searching for a document named “Plan Contact Matrix” and enter **plan contact**, the search fails. Use wildcards to broaden your search.
- All Windchill searches are case insensitive.
Use the following procedure to perform a global search:

1. From the drop-down menu on the left, select **All Types** or one or more specific object types:

   ![Drop-down menu with object types](image)

   - **Part**
   - **Document**
   - **CAD Document**
   - **Problem Report**
   - **Change Request**
   - **Change Notice**
   - **Abstract Specifica...**
   - **Requirement**

   - **All Types**

   ![Search field and icon](image)

   **Note**
   
   You can modify the list of available object types using the **Global Search Default Types List** preference. To set this preference, navigate to **Quick Links ▶ My Settings ▶ Preferences**. Expand the **Search** preference group and right-click **Global Search Default Types List** to change your preference setting. For more information, see **Preference Management**.

2. Enter one or more words in the search field. Text separated by spaces is interpreted as separate search strings joined by an AND operator.

3. Click the search icon or press ENTER to start the search.

   Search results appear in the **Search** tab. For more information, see **Search Results**.
Tip

- To cancel a search that is in progress, click the cancel icon \(\times\) next to the search progress indicator above the **Search Results** table.
- Use the drop-down menu next to the **Search** field to access your search history and saved searches, or open the **Advanced Search** page:

For more information, see **Search History**.

Advanced Search

Use the Windchill advanced search capability to perform detailed search queries. Using more specific criteria reduces search time and limits the number of database objects that are returned. Advanced search also allows frequently used searches to be saved, shared with others, altered, and reused.

To access the advanced search, open the **Navigator** and select the **Search** tab. Click **Advanced Search** at the top of the tab. You can also select **Advanced Search** from the global search drop-down menu:

For more information, see **Advanced Search**.
Saved Searches
You can save search criteria sets on both the Search and Advanced Search pages. This makes frequently performed or highly detailed searches more convenient. Individual users can save searches for their own use; administrators can create saved searches and assign them to groups of users. For more information, see the Saved Searches section of the PTC Windchill Help Center.

Using Windchill Workspaces
Windchill Workgroup Manager provides you with a workspace – a private area managed by Windchill that enables you to collaborate on a project with other designers.

The primary purpose of a workspace is to allow you to work on a portion of a design without impacting data in the Windchill commonspace. Once you are ready to expose design changes to the rest of your team, you can check in your design in Windchill.

⚠️ Tip
In Windchill, you can create multiple workspaces. This is useful if you are working on several projects at a time, enabling you to maintain each project’s data in a dedicated workspace.

For more information, see the Introduction to the Workspace Help Center topic.

Viewing Objects in a Workspace
Once you save a file from your application or check out an object from Windchill, it appears in your private active workspace in Windchill.

To view objects in your workspace, click the active workspace node in the Folder navigator. The embedded browser shows the contents of the workspace.

⚠️ Tip
You may wish to customize the view of the workspace table (for example, add columns that display important object attributes) by creating a new table view or modifying an existing one. You can create several views for different purposes. For example, you may have a view that shows the status of the objects, such as out-of-date. For more information on creating custom views of the workspace table, see the PTC Windchill Help Center topic, Creating and Editing New Table Views.
To obtain information about an object in the workspace, open its information page by clicking the information icon. The information page called from the workspace presents the workspace-relevant details for the object.

**Tip**

The object’s information page opened from the commonspace may have different contents than the information page opened from the workspace.

You can configure how objects are displayed in the workspace table by selecting the desired view. You can select one of the following views:

- As a List (default)
- Featured Objects—Featured Objects is a view designed to restrict the number of objects displayed in the workspace to the ones likely to be the most interesting to you, as defined by the following rules:
  - Include objects initially selected for Add to Workspace or Check Out actions
  - Include all checked-out objects
  - Include all objects modified locally or in the server-side workspace
  - Include drawings included for selected items

**Note**

The **Featured Objects** view filter is sticky, and will retain your last view selection should you navigate away from the workspace and return. Toggling the view between **As a list** and **As a Featured Objects list** in the workspace toggles the value setting for the preference, **Workspace Display**, between **All items** and **Featured items**, respectively.

**Populating a Workspace**

There are several ways to populate your workspace. Some of them include:

- Save an object from your CAD application’s session using **Save** or **Save to Workspace**.
- Locate and then check out and download an object from a commonspace folder in Windchill to your workspace.
- Import objects into the workspace from a location on your hard disk.
Creating and Activating a Workspace

You can create a new workspace either from Creo Parametric using the Server Management utility or from a workspace table in Windchill.

Creating a New Workspace using the Server Management Utility in Creo Parametric

1. From Creo Parametric, select Tools ▶ Server Management; or in the ribbon, select File ▶ Manage Session ▶ Server Management. The Server Management window opens.

2. Click Workspace ▶ New.

3. Specify a unique name for the workspace and select the context (product or library) where you want the workspace to reside.

4. Click OK. The new workspace is added to the list of the workspaces in the Server Management window, and it immediately becomes your active workspace.
Creating a New Workspace from a Workspace Page in Windchill

1. In the embedded browser or in standalone Windchill, browse to find the product within which you want to create a workspace.
2. On the Browse tab, expand the product node and click the Workspaces link.
3. In the My Workspaces table that appears in the content pane, click the new workspace icon.
4. In the New Workspace window, specify a unique name for the workspace.
5. Optionally, provide a description for the workspace.
6. Select the Activate checkbox (not available in a standalone browser) to make the new workspace active upon creation.
7. Click OK. The system confirms that the new workspace is created.

Activating a Workspace

You can designate a particular workspace as the active workspace. The active workspace is used as the default location for data management functions.
1. In Creo Parametric, select **Tools ▶ Server Management**, or in the ribbon, select **File ▶ Manage Session ▶ Server Management**.

2. In the **Server Management** window, right-click a workspace that you want to activate from the list of workspaces available on the selected server. Continue as follows:
   - To activate a workspace on the primary server, click **Activate ▶ Workspace**.
   - To activate a workspace and make its server the primary server, click **Activate ▶ Workspace and Set Primary**.

**Working with Windchill**

The next sections cover the most typical PDM actions that you may use while working on your design.

**Starting Out on a Design**

The next sections describe different scenarios for how you may start working on your design using Windchill.

**Creating a New CAD Document**

CAD documents are Windchill objects that are used to manage Creo Parametric data in Windchill.

CAD documents can be created using the following approaches:
   - On-the-fly – When you create and save a new object in Creo Parametric.
   - Created from Windchill – When you create a new CAD document in the workspace. This can be done from the embedded browser or from standalone Windchill browser.

**Creating a New CAD Document from Creo Parametric**

When you create a new object in Creo Parametric and save it to the workspace, it creates a new CAD document in your workspace.

**Creating a CAD Document from a Workspace Page**

1. Go to the workspace page in the embedded browser or in a standalone Windchill browser.

2. From your workspace page, select **File ▶ New ▶ CAD Document** or click the new CAD document icon 🚀. The **New CAD Document** window opens.
3. Specify the following fields:
   • **Organization ID**
   • **Authoring Application**—Selecting the authoring application may preselect values for other attributes, for example **Category** and **Type** and **Template Name**.
   • **Category**
   • **Type**
   • **Template Name**—Select the CAD document template to use.

💡 **Tip**
You can click the **Default** button to save the currently-selected template as the default. When you revisit the **New CAD Document** window, the previously-saved default value is preselected in the **Template Name** menu.

4. Specify values for the attributes in the **Attributes** pane. The attributes listed depend on the template selected, but typically the following attributes are available out-of-the-box:
   • **Number**

⚠️ **Note**
If autonumbering is on, **Number** is not shown as a required field and the word **Generated** is displayed.

   • **Name**
   • **File name**
   • **New Revision**
   • **Description**
   • **Location**

⚠️ **Note**
The default location is the current workspace. If you want to specify a different location, click **Select Folder** and enter a path or browse to a folder within your selected context.
5. If you want to open the newly-created CAD document in the authoring application, select the **Open in Authoring Application** checkbox (available in the embedded browser only).

6. Click **Finish**. The new CAD document is created in the target workspace.

**Importing Files into Windchill**

There are two ways to import your objects into Windchill:

- **Import objects into the workspace using the embedded browser**—You can use **Tools ▶ Import to Workspace** to select files from your local disk or another location and import them into your workspace. Selecting a top-level assembly default collects all required dependents for import.

**Note**

Import into the workspace is not supported for the files that come from multiple authoring applications.

- **Save an opened file to your workspace**—When your Creo Parametric session is connected to a Windchill server, you can open an object in your application from a location other than a workspace. Then you can use **Save to Workspace** to save the active object in session with its dependents to the workspace. For more information, see **Saving Your Work to the Workspace** on page 92.

For more information, see the [Importing Objects to the Workspace Help Center topic](#).

**Opening Objects in Creo Parametric**

You can open CAD documents from a workspace, or from various places in the commonspace while working in the embedded browser of a Creo Parametric session. In addition, you can open CAD documents from a standalone browser if an appropriate installation of Creo Parametric is installed on your machine.

**Opening Workspace Object from the Embedded Browser**

To open a listed workspace CAD document in Creo Parametric, select **File ▶ Open In ▶ Open in Creo** or click the open in Creo icon in the **Actions** column for the object. The object is opened in your current Creo Parametric session. You can also access the **Open in Creo** action from most places where CAD documents are exposed in Windchill, as explained in the following section.
Note

You cannot open CAD documents for UDFs, incomplete objects, or any file type for which direct retrieval is not allowed in Creo Parametric.

Opening Objects from a Standalone Browser

When you are working in a standalone browser and an appropriate version of Creo Parametric is installed on your machine, you can open CAD documents in Creo Parametric. If a Creo Parametric session is already running, the object is opened in your existing session. If no session is running, the action of opening an object automatically launches Creo Parametric.

The action for opening CAD documents is available in Windchill generally where CAD documents are exposed. In addition to the workspace, these places include the Folder page (when CAD documents are displayed), the search results page, the CAD document Structure tab, the Product Structure tab (when associated CAD documents are displayed), and the CAD document information page. The action can be initiated either by clicking the open in Creo Parametric icon in the Actions column for the object, or selecting Open In ▶ Open in Creo from an actions menu.
Checking Out Files from Windchill to Make Changes

Checking out an object reserves the object for you, so you can make changes to the object. There may be different scenarios for a checkout:

- If you have an object in your Creo Parametric session that is downloaded but not checked out, the object is treated by the system as a read-only file. Prior to modifying the downloaded file, you must first check it out. From the authoring application, use **Check Out**.

- You can check out an object “on-the-fly”. If a CAD document is opened in Creo Parametric but is not checked out, saving the document from the application causes a conflict. To resolve the conflict, you can check out the object using the **Conflicts** window.

- You can search Windchill and locate an object in the commonspace, and then check it out into an existing or new workspace using the **Actions** menu.

For detailed information, see the **Checking Out Objects** Help Center topic.

Adding an Object to the Workspace

1. In Windchill, locate the part/assembly of interest.
2. Right click the object and select **Add to Workspace**.
3. The **Add to Workspace** page opens on the **Basic** collection tab that specifies the related objects (in addition to the ones you selected) that are collected for the **Add to Workspace** action.

**Note**

The default setting – **Dependents** is set to **Required** — specifies that all dependent children (which are necessary to fully define the selected object) are included for the **Add to Workspace** action.

4. Accept the default and click **OK**. This loads the objects into the selected workspace.

**Note**

The default target location is your active workspace.

Once CAD documents are in your workspace, you may want to open them in the authoring application. In the **Actions** column, click **Open in Authoring Application.** From the workspace, or from almost any place in Windchill that an object is listed, you can click the icon to access the object information page.

For more information, see the **Adding Objects to the Workspace Help Center** topic.

**Saving Your Work to the Workspace**

Use **Save** to save a modified or a new object that is open in your authoring application.

1. In an active session of your authoring application, click **File ▶ Save.**
2. Enter a name for the file or accept the default.
3. Click **OK.** The file is saved to the workspace in the local managed directory.

**Tip**

To save the object to the server-side workspace, use **File ▶ Save and Upload**
Checking In Your Work to Windchill

To make your modifications available to other members of the team, you need to check in the object into Windchill. Checking in your files removes the lock on the reserved objects.

The Creo Parametric integration with Windchill provides two ways to check in an object:

- **Auto Check In**–Checks in objects from the active session of Creo Parametric to the Windchill server using default values set in your workspace's configuration specification. This method of checkin is only available from Creo Parametric.

- **Custom Check In**–Allows you to specify options for the check-in process. The custom method is available from both Creo Parametric and the workspace page.

**Note**

After you have checked in your object into Windchill, you may want to clear your workspace. For more information, see Clearing a Workspace on page 97.

For more information, see the Checking in Objects Help Center topic.

Undoing a Checkout

You may need to undo a checkout if you do not intend to check in your changes to Windchill. This can be done from an active session of your authoring application or from the workspace page by selecting **Undo Checkout**.

Keeping Your Workspace Objects Up-to-Date

An object stored in your workspace can become out-of-date after other users have made modifications to some of its components. You can update selected workspace objects to make sure they remain current with the latest server information.

You can check the status of a workspace object by adding these optional status columns to your workspace table view:

- Out of Date Status
- Out of Date with Workspace Configuration Status

If you set up a view to show the status column, a glyph 🙁 indicates that the object is out-of-date.
Note

Due to performance considerations, you may want to create a custom view that can display the optional status columns when needed (using the default view for more rapid performance during routine PDM activities). For more information on creating custom views of the workspace table, see the Windchill Help Center topic, Creating and Editing New Table Views.

To update objects in the workspace, use the workspace **Update** action available from the workspace page of the embedded browser or standalone Windchill.

Tip

Another way to make sure everyone on the project has access to an up-to-date design is to periodically check in your updates into the commonspace.

For more information, see the Keeping Workspace Objects Up-to-Date Help Center topic.

Copying Objects Using Save As

You may want to use an existing design as a basis for a new design. The original design may reside in a folder in the commonspace on the Windchill server, or it may be located in one of your workspaces.

For details, see the About Using Save As Help Center topic.

Using Save As from the Commonspace

You can search the commonspace on the Windchill server to locate the desired object, and then use **Save As** to create a copy of that object on the Windchill server.

Consider this information about copying objects from the commonspace:

- When you copy a top-level object and all of its lower-level parents, a new complete parallel structure (CAD structure) is created for that object.
- If you did not select the top-level object and all of its lower-level parent objects, the system creates copies of only the objects that you explicitly selected.
To create a copy:
1. Search or browse Windchill folders to locate the desired object or structure in Windchill.
2. Open the information page of the object.
3. Select **Save As** from the actions list.

**Note**
During the Save As operation, you can assign new names to the copied object using the **Set New Name** on the **Save As** page.

**Using Save As from the Workspace**

The workspace **Save As** action allows you to create copies of new objects that are located in the workspace. These newly created objects are not saved to the commonspace until you perform a checkin. The workspace **Save As** can be useful if you want to investigate alternate design scenarios before selecting the one that you want to check in into the commonspace. That way you do not clutter the database with alternative design versions, and only check in the version that you want to develop further. The rejected designs can be easily removed from the workspace.

The workspace **Save As** allows you to update a dependency from an existing parent object to the newly-duplicated object, letting you replace an old component with a newly-duplicated component without involving the authoring application. In addition, circular dependencies can be detected and managed.

1. Select an object in the workspace that you want to save as a new object and click **File ▶ Save As**.

**Note**
Locally modified or incomplete objects, or objects that have never been uploaded, are not eligible for Save As.

2. Use the **Configuration** menu to set rules for the dependency and configuration of objects to be listed in the **Save As** table.
3. Select one or more objects and click the appropriate collection toolbar action to gather, remove, exclude, or include related objects in the **Save As** table.
4. By default the system appends an underscore to the original name. You specify a naming using the naming icon ⚙.
5. By default, Save As creates new objects. However, you can specify that the original object is reused by selecting the object and clicking the reuse icon.

6. By default, newly-saved-as objects are stored in the same location as the original. To set a different location, select one or more objects and click the set location icon.

7. Click Next to update a dependency from a parent object, or click Finish to complete the Save As operation without updating parent objects.

Renaming Objects
You can use Rename from the workspace to rename only objects that have never been checked in. After the objects have been checked into the commonspace, you can no longer rename them from the workspace. Instead, you can rename them from the commonspace if you have Modify Identity access permissions.

1. From the workspace, select one or more new objects to rename and select File ▶ Rename.

or

From the commonspace or a commonspace view of an object information page, select Rename from the Actions menu.

2. Set new values in the New Name and New File Name fields. You can either enter values directly into the text fields available in each object's row, or you can select object rows and click the set new name icon to access the Set New Name window where you can specify patterns for renaming objects.

3. Selecting one or more objects and clicking the reuse icon keeps its current name within the newly-named object structure.

4. Click OK.

Making Your Environment Work For You
The next sections provide tips for how to set up your working environment.

Using the Event Management Utility
You can use the Event Management utility to review log messages generated in Creo Parametric or in a Windchill session.

The Event Management utility can be accessed in the following ways:

• By selecting the Event Management link under Quick Links at the top of a Windchill page

• From a workspace, by selecting Event Management from the workspace actions menu
• From Creo Parametric, by clicking the console status icon in the status bar
• By selecting **Tools ▶▶ Event Management**; or in the ribbon, **File ▶▶ Manage Session ▶▶ Event Management** in Creo Parametric.

In a standalone browser, the **Event Management** utility starts automatically whenever a transaction fails. When using the embedded browser, a console status icon appears in the status bar.

For detailed information, see the **Using the Event Management Utility** Help Center topic.

### Clearing Cache

To clear cache from a specific workspace:

1. Click **Tools ▶▶ Server Manager**; or in the ribbon, click **File ▶▶ Manage Session ▶▶ Event Management**. The **Server Management** window opens.
2. Click the **Cache** tab in the **Server Management** window.
3. Click **Cache Tools**.
4. In the **Cache Management** window, double-click a server in the **Location** list. The **Location** list expands to show all workspaces on the selected server.
5. Select a workspace and click **Clear Cache**. The cache for the selected workspace is deleted.

### Setting Preferences

The Creo Parametric integration with Windchill allows you to set preferences that control certain aspects of the system behavior (for example, the behavior of **Revise** or **Undo Check Out** and customize some features of the user interface.

Depending on the nature of the preference, it can be set on the server or on the client. Server-side preferences are set using the **Preference Management** utility. Client-side preferences can be set in two ways:

- The **config.pro** file
- Environment Variables

For more information about server-side preferences, see the **Preference Management** Help Center topic.

For more information about client-side preferences, see the **Configuration Settings in Creo Parametric** Help Center topic.

### Clearing a Workspace

After you have checked in a modified object to Windchill, you can clear the workspace to remove objects and their dependents.
1. Go to the workspace page in the embedded browser or in standalone Windchill.
2. Select an object that you want to remove from the workspace.
3. Click File ▶ Remove or click the remove icon in the toolbar. The Remove from Workspace page appears, displaying your initially selected objects.
4. You can collect, remove, include, or exclude objects for the Remove action.
5. Click OK at the bottom of the Remove from Workspace page. The selected objects are removed from your workspace.

⚠️ Caution

If you remove a checked-out object from your workspace, the checkout is undone, and any modifications made to the object are lost. In addition, the removed objects are erased from your CAD session.

CAD Document Templates and Creo Parametric Start Parts

Both Windchill and Creo Parametric use default template files when creating a new object. In Creo Parametric these objects are called start parts and in Windchill they are referred to as CAD document templates. The Creo Parametric start parts traditionally reside on your local file system, while the CAD document templates are stored in the Windchill database. In a concurrent engineering environment, you may find it challenging to keep all of your CAD document templates up-to-date with your Creo Parametric start parts.

To remedy this, you may find it useful to manage your Creo Parametric start parts in the Windchill database. Additionally you can also create new CAD document templates that reference the same start part files. The result is that regardless of whether a designer uses Creo Parametric or Windchill to create a new object, both applications use the same set of template files.

Other advantages to managing your start parts in Windchill PDMLink are:

- They are easily updated.
- They are easily distributed.
- They are version controlled.
- Same objects are used for all new Creo Parametric CAD documents.

For more information, see the Managing Creo Parametric Start Parts in Windchill Help Center topic.
Installing Windchill Workgroup Manager for a Third-Party CAD Application

PTC Windchill PDM Essentials automatically installs Windchill Workgroup Manager for third-party CAD applications on the server but each user must install Windchill Workgroup Manager on their local machine.

To install Windchill Workgroup Manager:

1. On the Windchill Home page, click Quick Links ▶ Software Downloads
2. In the list of available downloads, click Windchill Workgroup Manager.
3. Under Installing Windchill Workgroup Manager Client, click Start Installation.
4. Under Windchill Workgroup Manager Manuals, click the applicable user guide. The user guide opens in PDF format. Use this guide for installation instructions.

For information about configuring Windchill Workgroup Manager and setting up integration between Windchill and a third-party CAD application, refer to the Getting Started chapter of the applicable user guide.

Refer to the PTC Support page for Windchill Workgroup Manager user guides: https://www.ptc.com/appserver/cs/doc/refdoc.jsp?p=browse_results&Product=Windchill+PDMLink&Release=10.2&DocType=3319&Role=

You can also find Help Centers for Windchill Workgroup Manager and other applications on the PTC Support page at the following URL: https://www.ptc.com/appserver/cs/help/help.jsp
After completing the simple installation assistant and the Windchill Setup Assistant for PTC Windchill PDM Essentials, your environment is ready for production. This section lists administrative tasks necessary to maintain Windchill and ensure optimal performance moving forward. Each listed administrative task includes basic information and provides applicable references. Administrative tasks are grouped as follows:

- **Business Administrative Tasks on page 103**—These tasks are performed within the Windchill application and are often performed by an organization administrator:
  - Managing Users
  - Managing Products and Libraries
  - Promoting Items
  - Managing CAD Application
  - Managing Publishing Jobs

- **System Administrative Tasks on page 119**—These tasks are performed in the Windchill environment, not in the Windchill application and are often performed by a site administrator:
  - Managing Backups
  - Managing Space on the File Vault
  - Applying Windchill Patches
  - Managing License Use
○ Restarting the Windchill Windows Service
○ Uninstalling PTC Windchill PDM Essentials

For an introduction to Windchill administration, see the Getting Started with Windchill Administration Help Center topic, as well as the Resources for PTC Windchill Administrators Quick Reference Guide.

Best Practices: Scheduling Administrative Tasks

It is important for you to create your organization’s administrative schedule. The following Help Center topic will help you determine which administrative tasks should be done regularly and how often each should be done:

Best Practices for Monitoring and Maintenance.
Business Administrative Tasks

The following administrative tasks are performed in the Windchill client:

- Site Administration and Organization Administration on page 103
- Managing Users on page 104
- Managing Products and Libraries on page 107
- Managing the Promotion Process on page 109
- Managing CAD Application on page 110
- Managing Publishing Jobs on page 110

Site Administration and Organization Administration

Windchill contexts provide the framework for collecting and finding related information. Windchill information is organized and managed within a context hierarchy.

For more information about the basics of contexts, see the Contexts Overview Help Center topic.

For detailed information about the hierarchy of contexts, see the Context Inheritance Help Center topic.

The organization you specified in the installation assistant is intended to represent your company and to contain and organize the data for your company employees.

Some business administrative tasks are performed at the site level, some are performed at the organization level, and some can be performed at both levels:

- Managing Users on page 104—Must be performed at the organization level.
- Managing Products and Libraries on page 107—Recommended to be performed at the organization level.
- Managing the Promotion Process on page 109—Performed at the organization levels. See applicable section below for details.
• **Managing CAD Application on page 110**—Performed at the site or organization level, depending on the specific task. See applicable section below for details.

• **Configuring a Remote CAD Worker for Autodesk Inventor and SolidWorks on page 110**—Must be performed at the site level.

For an overview of administering contexts, see the Contexts – Distributed and Hierarchical Administration Help Center topic.

**Managing Users**

During initial installation and configuration, the *Windchill Setup Assistant* includes a page to add users to Windchill. When adding users during this step of the configuration, the *Windchill Setup Assistant* provides five groups to which the new users are added. These groups also define profiles, roles, and shared teams. Users should be managed at the organization level so that they belong to an organization.

When adding new users to Windchill post-configuration, in order to ensure the proper behavior, add them to one or more of the five PTC Windchill PDM Essentials groups during the **Assign to Groups** step of the **New User** window.

For detailed information about adding users to Windchill and accessing the **New User** window, see the Creating a New User Help Center topic.

Use the following procedure when assigning a new user to one or more of the out-of-the-box groups in the **New User** window:

1. In the **Assign to Groups** step, click one of the following icons to add groups to the table:
   - Add the group to table icon
     a. In the **Find Participant** window, enter values for one of the five out-of-the-box roles in the search criteria fields and click **Search**.
**Note**

The selection criteria fields are not case-sensitive and you can include the asterisk (*) wildcard character. You can also click **Search** without entering any values in the fields to display all available groups.

For more information about the PTC Windchill PDM Essentials out-of-the-box roles, groups, profiles, and shared teams, and how they are configured, see Participants on page 58.

Groups matching the specified criteria appear in the **Search Results** box.

b. Click each group that you want to assign, and then click **Add** to add the selected groups to the **Participant List** box. More than one group can be selected by using Ctrl and Shift keys.

**Note**

Although there are other standard Windchill groups available, in order to ensure the proper behavior, add users to one or more of the five PTC Windchill PDM Essentials groups. For a description of these five roles, see Participants on page 58.
c. Click **OK** to add groups to the **Groups** table.

2. Select **Finish** to add the group assignment to the database and close the **New User** window.

These groups automatically associate the new users with the appropriate profiles, and shared team roles for products and libraries.

**Note**

The **Manager** group is automatically added to the **Product Creators** group and the **Library Creators** group. Only members of these groups can create products and libraries, respectively.

For more information about managing users, see Using the Participant Administration Utility.
For information on how to change user passwords from the Participant Administration utility, see the Changing User Passwords Help Center topic.

When instructing users to change their own password, refer them to the following Help Center topic: Changing Your Password.

For more information about roles and groups, see the About Roles and Groups Help Center topic.

For more information about profiles, see the Profiles Help Center topic.

Managing Products and Libraries

- Products—A product is typically thought of as the physical item manufactured and sold to customers. Windchill expands the concept of a product to include the environment in which users collaborate to develop that end item part. This environment is known as the product context.

  For more information about products, see the About Products Help Center topic.

- Libraries—A library provides a place for storing and providing access to commonly used objects that are shared across multiple products. Libraries correspond to your company's organization and processes. For example, standard hardware files, that are controlled by industry standards and that CAD Authors have read-only access to, can be shared and associated with multiple products. This environment is known as the library context.

  For more information about libraries, see the About Libraries Help Center topic.

It is recommended that products and libraries are managed at the organization level.

PTC Windchill PDM Essentials includes an out-of-the-box product template and an out-of-the-box library template, each with a corresponding shared team. New products and libraries are created using these templates. Although you can create additional templates, it is recommended that these out-of-the-box templates are used for creating new products and libraries in order to ensure proper behavior. For more information about the PTC Windchill PDM Essentials out-of-the-box library and product templates, see Library Template on page 63 and Product Template on page 64.

An out-of-the-box library context called Parts Catalog is pre-configured for immediate production. This library uses the out-of-the-box library template and includes all of the applicable configurations.
An out-of-the-box product context is not pre-configured. When planning the administration and management of product contexts, keep in mind the following two options:

- **Single Product Context**—Create a single product context for all products and projects. Each product or project is created as a sub-folder within the main product context.

  Benefits of the Single Product Container model include the following:
  - Easier to manage and navigate
  - Easier to collect and share related information that crosses products

- **Product Context for Each Product/Project**—Create a product context for each product or project.

  Benefits of creating a product context for each product or project include the following:
  - More flexible—If you do project engineering work, it is often easiest to manage each project using a separate product context where you can configure the folders and team roles uniquely for each project. You can also define attributes for each product or project (such as customer name, project number, start date, delivery date, and status) and create reports that are specific to the project.
  - More scalable—If you have a very large number of products or projects, you may find it difficult to navigate and to search among the items in a single product context and you may find that opening the folders page for a single context is slow (such as when you have hundreds of top-level folders representing projects). Creating a product context for each product or project makes navigation and searching easier when there is a large number of products or projects.
  - Easier to control access—If you need to separately control access to each product or project, it is usually easier to accomplish when you use separate project contexts (with separate teams) than with a single product context.

For more information about product and library administration, see the Working with Products and Libraries Help Center topic.

---

**Note**

The **Manager** group is automatically added to the **Product Creators** group and the **Library Creators** group. Only members of these groups can create products and libraries, respectively.
When administering products and libraries, keep in mind the following:

- **Teams**—Products and libraries have teams, the members of which are assigned to roles that define their privileges within the context. A product or library team can consist of a local team, a shared team, or both. PTC Windchill PDM Essentials includes an out-of-the-box product template and an out-of-the-box library template, each with a corresponding shared team. It is recommended that these templates are used for creating new products and libraries.

For more information about product and library teams, see the About Context Teams Help Center topic.

For more information about local teams, shared teams, and defining a context team, see the Defining a Context Team Help Center topic.

For more information about the PTC Windchill PDM Essentials out-of-the-box groups, shared teams, and roles, and how they are configured, see Participants on page 58.

For more information about the PTC Windchill PDM Essentials out-of-the-box library and product templates, see Library Template on page 63 and Product Template on page 64.

- **Modifying Access Control**—As an administrator, you must ensure that only the appropriate participants have access to objects, such as documents and CAD documents. Decisions about access rights are expressed as access control rules. Access control is configured based on the PTC Windchill PDM Essentials out-of-the-box groups and life cycle states.

For more information, see the Access Control Overview Help Center topic.

  - Security Management—The security management functionality provides a mechanism to view and manipulate access control permissions on individual objects (such as documents, CAD documents, and folders).

    For more information, see the Security Management Help Center topic.

  - Policy Administration—The **Policy Administration** utility is used to manage administrative domains and the access control, indexing, and notification policies for those domains. An administrative domain is an area that defines a set of administrative policies. A policy is a collection of rules for types of objects within a domain.

    For more information, see the Policy Administration Help Center topic.

### Managing the Promotion Process

- **Life Cycle States**—An organization administrator from the Administrator group or a user in the Manager group/role can create a variety of life cycles or modify existing life cycles. These life cycles define the states and transitions associated with various business objects and the available transitions between those states.
For more information, see the Life Cycle States Help Center topic.

For more information about the PTC Windchill PDM Essentials out-of-the-box CAD Document life cycle, see CAD Data Management Life Cycle on page 67.

- Set State Actions—For information on the procedure of changing the state of an object, see the Setting the State of an Object Help Center topic.
- Promotion Requests—You can use the promotion request processes to formally request a state change for a set of objects that reside in products or libraries.

For more information, see the Promotion Requests Help Center topic.

Managing CAD Application

The Integrating with Your CAD Application on page 73 section of this guide describes administrative tasks to get started with the integration between PTC Windchill PDM Essentials and your CAD application. This integration requires a few regular administrative management tasks. Refer to the following Help Center topic for common management tasks moving forward:

Common CAD Management Activities

For more information about administrative tasks specific to the integration between Creo Parametric and PTC Windchill PDM Essentials, see the Administration and Configuration Help Center topic.

Managing Publishing Jobs

It may periodically be necessary to manage publishing jobs, including viewing the status of jobs, troubleshooting jobs, view individual jobs or queues, manage subscriptions, and so on. This is managed at the site level.

For more information, see the Windchill Visualization Services Publishing Help Center topic.

Configuring a Remote CAD Worker for Autodesk Inventor and SolidWorks

PTC Windchill PDM Essentials is configured with the Creo Parametric CAD worker installed on the same machine as Windchill.

If you wish to publish formats for Autodesk Inventor or SolidWorks, you must purchase the CAD adapter for these applications and configure a CAD worker on a separate physical or virtual machine because Autodesk Inventor and SolidWorks do not support installation into a Windows Server operating system.
The below sections outline the steps to configure a remote CAD worker for the following products:

- Autodesk Inventor
- SolidWorks
## Configuring a Remote CAD Worker for Autodesk Inventor

To configure a remote CAD worker for Autodesk Inventor:

<table>
<thead>
<tr>
<th>Step</th>
<th>For Details, see</th>
</tr>
</thead>
</table>
| 1. Install supported Autodesk Inventor application release on a remote machine with a supported operating system. | To determine which releases of Autodesk Inventor and operating system platforms are supported (non-File-Sync), refer to the relevant Creo View Adapters Software Matrix (MOR-specific), located at the following URL: [https://www.ptc.com/view?im_dbkey=148979](https://www.ptc.com/view?im_dbkey=148979).  

To determine which Autodesk Inventor, Creo View Adapters, Windchill, and Windchill Workgroup Manager release combinations are supported, refer to the File Sync Article, located at the following URL: [https://www.ptc.com/appserver/cs/view/solution.jsp?n=CS51623](https://www.ptc.com/appserver/cs/view/solution.jsp?n=CS51623).  

**Note**  
PTC Windchill PDM Essentials is a Windchill solution. The above links that reference the Windchill platform apply to PTC Windchill PDM Essentials.  

Review the Adapter Prerequisites section of the *PTC Creo View MCAD Adapter Installation and Configuration Guide*Creo View MCAD Adapters 2.0 Installation and Configuration Guide (located at the following URL: [https://www.ptc.com/view?im_dbkey=152325](https://www.ptc.com/view?im_dbkey=152325)) to ensure your system meets the necessary prerequisites.  

To install the licensed Autodesk Inventor application release on the chosen machine, refer to the relevant information in your Autodesk Inventor documentation. |
<p>| 2. Install and configure Creo View Adapter for Autodesk Inventor. | See the Configuring the Creo View Adaptor for Inventor chapter of the Creo View MCAD Adapters 2.0 |</p>
<table>
<thead>
<tr>
<th>Step</th>
<th>For Details, see</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step</td>
<td>For Details, see</td>
</tr>
<tr>
<td>---------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>3. Configure the common file system for transferring data to and from the remote worker.</td>
<td>Configure the common file system according to the steps in the Configuring a Worker on a Different Windows Machine &gt; Creating a Common Windows-to-Windows File System section of the PTC Windchill Visualization Services Guide. The PTC Windchill Help Center topic is located at the following URL: <a href="http://www.ptc.com/cs/help/windchill_hc/wc102_HC/index.jspx?id=WorkAgentConfigWorkDifferentWindowMachine&amp;action=show">http://www.ptc.com/cs/help/windchill_hc/wc102_HC/index.jspx?id=WorkAgentConfigWorkDifferentWindowMachine&amp;action=show</a>.</td>
</tr>
<tr>
<td>4. Configure the WVS Worker Agent for the remote worker.</td>
<td>Configure the WVS Worker Agent according to the steps in the Configuring a Worker on a Different Windows Machine &gt; Adding a Worker to a Different Windows Machine section of the PTC Windchill Visualization Services Guide. The PTC Windchill Help Center topic is located at the following URL: <a href="http://www.ptc.com/cs/help/windchill_hc/wc102_HC/index.jspx?id=WorkAgentConfigWorkDifferentWindowMachine&amp;action=show">http://www.ptc.com/cs/help/windchill_hc/wc102_HC/index.jspx?id=WorkAgentConfigWorkDifferentWindowMachine&amp;action=show</a>. Be sure to specify a Data Type of INVENTOR in the Add Worker panel of the Worker Configuration Wizard.</td>
</tr>
<tr>
<td>5. Test the new remote worker.</td>
<td>First, test the new worker from Windchill using the Worker Agent Administration UI Test action according to the Testing the Worker Agent Configuration section of the PTC Windchill Visualization Services Guide. The PTC Windchill Help Center topic is located at the following URL: <a href="http://www.ptc.com/cs/help/windchill_hc/wc102_HC/index.jspx?id=WorkAgentTestWorkAgentConfig&amp;action=show">http://www.ptc.com/cs/help/windchill_hc/wc102_HC/index.jspx?id=WorkAgentTestWorkAgentConfig&amp;action=show</a>.</td>
</tr>
<tr>
<td>Step</td>
<td>For Details, see</td>
</tr>
<tr>
<td>------</td>
<td>-----------------</td>
</tr>
<tr>
<td></td>
<td>Second, test the File Synchronization process by publishing a relevant INVENTOR CAD Part, CAD Assembly and CAD drawing from Windchill.</td>
</tr>
</tbody>
</table>
Configuring a Remote CAD Worker for SolidWorks

To configure a remote CAD worker for SolidWorks:

<table>
<thead>
<tr>
<th>Step</th>
<th>For Details, see</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Install supported SolidWorks application release on a remote machine with a supported operating system.</td>
<td>To determine which releases of SolidWorks and operating system platforms are supported (non-File-Sync), refer to the relevant Creo View Adapters Software Matrix (MOR-specific), located at the following URL: <a href="https://www.ptc.com/view?im_dbkey=148979">https://www.ptc.com/view?im_dbkey=148979</a>. To determine which SolidWorks, Creo View Adapters, Windchill, and Windchill Workgroup Manager release combinations are supported, refer to the File Sync Article, located at the following URL: <a href="https://www.ptc.com/appserver/cs/view/solution.jsp?n=CS51623">https://www.ptc.com/appserver/cs/view/solution.jsp?n=CS51623</a>.</td>
</tr>
<tr>
<td>2. Install and configure Creo View Adapter for SolidWorks.</td>
<td>See the Configuring the Creo View Adaptor for SolidWorks chapter of the Creo View MCAD Adapters 2.0 Installation and Configuration Guide,</td>
</tr>
<tr>
<td>Step</td>
<td>For Details, see</td>
</tr>
<tr>
<td>------</td>
<td>----------------</td>
</tr>
<tr>
<td></td>
<td>located at the following URL: <a href="https://www.ptc.com/view?im_dbkey=152325">https://www.ptc.com/view?im_dbkey=152325</a>.</td>
</tr>
<tr>
<td>Step</td>
<td>For Details, see</td>
</tr>
<tr>
<td>------</td>
<td>-----------------</td>
</tr>
<tr>
<td>4. Configure the WVS Worker Agent for the remote worker.</td>
<td>Configure the WVS Worker Agent according to the steps in the Configuring a Worker on a Different Windows Machine &gt; Adding a Worker to a Different Windows Machine section of the <em>PTC Windchill Visualization Services Guide</em>. The PTC Windchill Help Center topic is located at the following URL: <a href="http://www.ptc.com/cs/help/windchill_hc/wc102_hc/index.jspx?id=WorkAgentConfigWorkDifferentWindowsMachine&amp;action=show">http://www.ptc.com/cs/help/windchill_hc/wc102_hc/index.jspx?id=WorkAgentConfigWorkDifferentWindowsMachine&amp;action=show</a>. Be sure to specify a <strong>Data Type</strong> of SOLIDWORKS in the <strong>Add Worker</strong> panel of the <strong>Worker Configuration Wizard</strong>.</td>
</tr>
<tr>
<td>5. Test the new remote worker.</td>
<td>First, test the new worker from Windchill using the Worker Agent Administration UI Test action according to the Testing the Worker Agent Configuration section of the <em>PTC Windchill Visualization Services Guide</em>. The PTC Windchill Help Center topic is located at the following URL: <a href="http://www.ptc.com/cs/help/windchill_hc/wc102_hc/index.jspx?id=WorkAgentTestWorkAgentConfig&amp;action=show">http://www.ptc.com/cs/help/windchill_hc/wc102_hc/index.jspx?id=WorkAgentTestWorkAgentConfig&amp;action=show</a>.</td>
</tr>
</tbody>
</table>
Step | For Details, see
--- | ---
 | Second, test the File Synchronization process by publishing a relevant SOLIDWORKS CAD Part, CAD Assembly and CAD drawing from Windchill.

**System Administrative Tasks**

The following administrative tasks are performed in the Windchill environment:

- Managing Backups on page 119
- Managing Space on the File Vault on page 119
- Managing License Use on page 120
- Restarting the Windchill Windows Service on page 120
- Uninstalling PTC Windchill PDM Essentials on page 120
- Updating, Upgrading, and Moving Up on page 122

**Managing Backups**

It is important for you to plan and implement regular backups of Windchill. For detailed information on what to consider when setting up your backup policies and procedures, see *Windchill Backup and Recovery Planning*.

⚠️ **Note**

Backup of the Windchill Index Search files is not applicable for PTC Windchill PDM Essentials.

**Managing Space on the File Vault**

If the File Vault exceeds 85% of the total space, the administrator who provided their email address during the *Configuration* page of the installation assistant receives an email notification warning of low remaining file Vault space. If you cannot reconfigure the File Vault to allocate more space, change the location of existing files to free up space in the File Vault.

For more information, see the *Changing the Location of Files in External Vaults* Help Center topic.
Managing License Use

Windchill monitors the average number of concurrent licensed seats being used simultaneously. An audit report is regularly emailed to the administrator who provided their email address during the Configuration page of the installation assistant. This audit report helps administrators ensure that they are managing license use according to the number of licenses they have purchased.

Restarting the Windchill Windows Service

Certain circumstances may require the Windchill Windows Service to be restarted. This service, once started, automatically starts all of the Windchill components in the proper sequence. Access this Windows Service from the Start menu under Administrative Tools ▶ Services.

Uninstalling PTC Windchill PDM Essentials

1. Uninstall PTC Windchill Directory Server
2. Uninstall SQL Server
3. Delete the <PTC> directory
4. Delete <UserHome>\PTC\Windchill\psi_iir_index.xml
5. Remove the following Windows services:
   - PTC Windchill Directory Server
   - PTC HTTP Server
   - PTC Windchill

6. Reboot the server.

⚠️ **Caution**

This is a critical step. You must reboot the server.
Updating, Upgrading, and Moving Up

PTC Windchill PDM Essentials can be upgraded in the following ways:

- Updating to a New Maintenance Release on page 122
- Installing Critical Patch Sets on page 132
- Upgrading to a New Release of PTC Windchill PDM Essentials on page 134
- Moving Up to PTC Windchill PDMLink on page 145

**Note**

For more information, see the Types of Windchill Releases Help Center topic.

Updating to a New Maintenance Release

PTC Windchill PDM Essentials is updated in the same way as PTC Windchill PDMLink, using the PTC Solution Installer (PSI). In order to apply platform maintenance release updates to your deployment of PTC Windchill PDM Essentials, you must download the Windchill service packs located in the PTC Windchill PDM Essentials download files section of the PTC Support Web site: http://www.ptc.com/support/support.htm.

After downloading the required images, use the following procedure to apply a maintenance release update:

**Note**

PTC recommends that you always use a test (pre-production) system to ensure that your Windchill products are operating as expected before deploying them in a production environment. This allows you to identify any potential issues on the test system without interfering with production system activities. After you have installed the maintenance release on a test system and are satisfied with the results, repeat the maintenance release installation process on your production system. Because of the work you did on your test system, installing the maintenance release on your production system should take less time.

If you choose to update your production server directly, make sure to back up the server and database or take a snapshot if you deployed in a virtual environment. This enables you to restore your system if there is an issue with the update. For backup details, see step three below.
To prepare for the maintenance release or point release, read and understand the updates contained in the release and determine how they will affect your systems. This includes not only what steps must be performed to install the updates, but how the updates may affect configurations, site-modified files, and customizations as well as end users. Update information is located in the following places:

- **Current Windchill Content Overview**—Identifies the release highlights, the media available for the release and the delivery method for the updates.
- **Maintenance Fixes Table**—Identifies resolved issues. This information is organized by the maintenance release. You can get the latest version of this table from the PTC Online Support Web page for reference documents (http://www.ptc.com/appserver/cs/doc/refdoc.jsp). For your document search criteria, select your product from the **Product** drop-down list, select a release version from the **Reported Release** drop-down list, and select **Installation and Configuration Guide** from the **Document Type** drop-down list.
- **Windchill Maintenance Read This First**—Identifies the manual installation instructions to complete each maintenance release.

**Caution**

Make sure that the folder `<Installation_Location>/Windchill/logs` exist before beginning the update procedure.

Before updating, determine whether or not your source system is set up to use the Simple Number (also known as the Harvard Series) version scheme. Any existing document or CAD document has a version and iteration designator. The version scheme is Simple Number (Harvard Series) if the version of documents and CAD documents appears as 1.1, 1.2, ... 2.1, 2.2, ... etc. If your system uses the Simple Number (Harvard Series) version scheme, make a note before beginning; the update process requires an additional step. For more information, see **Post Update Steps for Simple Number (Harvard Series) Version Scheme** on page 130.

1. Create a staging directory on the target system for the images you downloaded. Place the media files in the new staging directory:
   a. Click **Copy to staging**.
   b. Click **Browse** and navigate to the directory containing the CD zip file or CD drive with the product CD.
   c. Click **OK**.
Note

A staging directory is a directory where you the product CDs before beginning the installation. This allows the PTC Solution Installer to access each CD image without stopping to prompt you during installation.

Using a staging area provides a faster installation experience and removes the need to insert CDs during installation.

2. If the implementation of Windchill at your site involves modifying files supplied by PTC, it is important to understand that the maintenance installation process could overwrite any file that is delivered by PTC (except for the site.xconf file). This includes files that you may have modified.

If you have made site modifications and are updating to a maintenance release or point release, PTC recommends that you follow the best practices established in the *PTC Windchill Customization Guide*, also available in the Setting Up a Directory Structure for Managing Customized files and Text Tailoring topic of the Help Center. In particular, make sure any site modified files are in the `<Windchill>/wtSafeArea/siteMod` directory.

Using the test system allows you to incorporate updates from PTC into any site-modified files and validate the maintenance release or point release with your own customizations without interrupting work being done on your production system. PTC recommends that you store a copy of all site-modified files in the safe area directory structure under the Windchill installation directory. Then, follow the below instructions by running the PTC Solution Installer with the service pack installation type option of "Updates for Site-Modified Files to Safe Area." You will have access to the files that PTC has changed for the maintenance release and can update your site-modified files accordingly. After updating your site-modified files, follow the below instructions again to run a "Complete" service pack installation on your test system to verify that the updated system, incorporating your site modifications, works according to your requirements.

To learn more about managing site-modified files, see the *PTC Windchill Customization Guide* or the Windchill Customization Basics section of the Help Center.

After you have installed the maintenance release or point release on a test system and are satisfied with the results, copy the site-modified files that you have updated to the safe area directory (<`Windchill>/wtSafeArea/siteMod`) on your production system. Then, repeat the maintenance release or point release installation process on your production system.
3. Prepare your system for the update by performing the following steps:
   a. Ensure that the test system and the production system are in sync.
   b. Take your production system offline by stopping any web server, servlet engine, or Windchill servers that could interact with the Windchill product files. This includes stopping the Windchill and Apache services (services.msc) and closing any application that may have a Windchill file open (for example, a text editor, a Windchill shell, or a Windchill log file).
   c. Delete the content in the `<Windchill>`\Tomcat\instances\ folders.
   d. When your system is offline, but before installing the maintenance release, perform all necessary backups. Backing up your files is an important step in the process. If you do not have backup files, you may not be able to restore files if an error occurs. At a minimum, you should back up the following:
      • Windchill database—Use the database backup procedures available for the SQL Server environment. This backup should follow your site’s data recovery processes.
       For more information, see the Backing Up the SQL Server Source Database Help Center topic.
      • Windchill solution installation directory—By default, this is C:\ptc. Back it up by creating a duplicate copy of it and keep it somewhere that follows your site’s data recovery processes.
      • Windchill solution LDAP directory content (LDIF file)—Execute the LDAP export procedure described in PTC Windchill Directory Server Administration Guide. Store the LDIF file somewhere that follows your site’s data recovery processes.
       For more information, see the Backing up LDAP Directory Data Help Center topic.
      • PTC Solution Installer Global Registry directory—Create a duplicate copy of the PTC Solution Installer Global directory called “installer” located in the `<Installation_Location>/PSI` directory. Store the PTC Solution Installer Global Registry directory somewhere that follows your site’s data recovery processes.
       To find out about the PTC Solution Installer Global Registry, see the The PTC Solution Installer Global Registry Help Center topic.
   4. If the system you are updating includes Windchill Workgroup Manager, ensure that the client JAR files are up-to-date. The Windchill Service Pack installation automatically rebuilds client JAR files. When you are selecting options in the PTC Solution Installer, be sure to select **Windchill Workgroup Manager** under optional products (see step 13).
5. Launch PSI:
   a. Insert the PTC Solution Installer CD.
   b. From a command prompt window, navigate to your CD drive, and then enter the following command: `setup.vbs`
      The PSI opens.
6. Choose the language for the installation session and click **OK**.

**Tip**

The **Before You Begin** panel provides links to necessary documentation to install your Windchill solution.

7. Accept the PTC Customer License Agreement.

8. Choose **Update Existing Installation** and click **Next**.

9. Select the installation to update and click **Next**.

10. On the Select Product page, select **Install Maintenance Release** and click **Next**
    - If your solution is not in the specified directory, the installer presents the **Products to be Updated** panel for you to specify the product location.
    - If you have made site modifications, the installer checks for the existence of the directory where the modifications are stored: `<Windchill>/wtSafeArea/siteMod` (where `<Windchill>` is the Windchill Services installation directory). The installer assumes that this directory holds a copy of all site-modified files. If the directory is not found, the **Confirm No Site Modifications Directory** message appears so you can confirm there are no site-modified files. Click **Yes** to continue or **No** and **Cancel** to quit the installation.

      For more information on site-modified files, see **Preparing to Update the Installation** in the Help Center.

11. Specify the staging directory that contains your media, and then click **Next**.

12. Select whether or not to preserve existing web configurations, and then click **Next**.
13. If installing an update to Windchill Workgroup Manager as part of the Windchill update, select the checkbox next to all applicable Windchill Workgroup Manager authoring applications you want to install.

**Note**

In addition to installing Windchill Workgroup Manager on the Windchill server, the user must also install the Windchill Workgroup Manager client software. Those instructions are located in the guide and in the Windchill Workgroup Manager Help Center under the Installation and Configuration section for the applicable CAD or authoring tool.

14. In the **Select Installation Type** panel, select **Complete**, and click **Next**.

15. PSI lists products and components that must be updated. Additionally, the PSI lists any products that need to be reinstalled to complete the update.

   Click **Next**.

16. If the Apache Web server and Tomcat require an update, this panel gives the option to preserve the configuration files. If you clear this checkbox, the existing `httpd.conf` file will be overwritten by the default `httpd.conf` file supplied by Apache. If you select the checkbox, the existing `httpd.conf` file will not be overwritten.

   Click **Next**.

17. On the Installation Overview page, review the information and click **Install**.

18. When the installation completes successfully, the **Installation Complete** panel displays the directories affected by the installation. Depending on the type of installation performed, the directories can include the selected directory where the installation took place, the selected directory and the `<Windchill>/wtSafeArea/ptcCurrent` directory, or only the `<Windchill>/wtSafeArea/ptcCurrent` directory.

   The installation log files are located in the `<Windchill>/installer/logs` directory. The log files for the installation are named:

   - `WSP_InstallLog.xml`
   - `WSP_PtcInstall.log`
Note

If the installation fails, a panel is displayed that contains error messages and the names of the relevant log files. The log files can be helpful in determining the cause of the failure.

Additional Windchill Service Pack install troubleshooting information can be found in the Troubleshooting Your Maintenance Installation Help Center topic.

If you file an installation support request, be sure to include the log files. There are separate log files for each Windchill Service Pack Installation that you do. Each set of log files is located in the installer/logs directory under the installation directory.

19. If your site uses HTTPS, reimport the certificate of authority into the jssecacerts file after you update your solution. For details, see the “Configuring HTTPS for PTC HTTP Server and Windchill” section of the PTC Windchill Installation and Configuration Guide or the Configuring HTTPS for PTC HTTP Server and Windchill Help Center topic.

20. The update tool should be run after completing an update to an existing installation using the Windchill Service Pack option (such as a maintenance release update).

Note

The web server, Windchill Directory Server, and database should be up and running before running the Update tool.
To execute the update tool, the following command must be executed from a Windchill shell by a Windchill administrator (wcadmin):

```
Update_Tool.bat -username <username> -password <password> -noui
```

⚠️ **Caution**

If the server gets shut down before the update tool completes running, an error occurs during startup when the Windchill service try to automatically start: The Windchill service on Local Computer started and then stopped. Some services stop automatically if they are not in use by other services or programs.

To resolve this issue:

a. Start the machine in safe mode.


c. Change the PTC Windchill PDM Essentials windows services Startup Type property values from Automatic to Manual.

d. Restart the machine.

e. Run the update tool.

If the following message appears, the Update tool has successfully completed: “Marking phase Load New Data as completed in the database.”

21. For Windchill Service Pack installations that update your Windchill solution installation directory, verify that the versions of the updated Windchill products are correct by navigating to Quick Links ▶▶ Help ▶▶ About Windchill PDM Essentials.

The Release and Datecode fields should reflect the correct updated version.

You can also run the windchill version command to verify the correct version of Windchill.

If the Windchill version shows that any component installations are incomplete, repeat the installation, selecting the Recover installation type option.

⚠️ **Note**

If you are first installing into a test system, you must repeat the installations in your production system.
22. See the *PTC Windchill Maintenance Read This First* for any manual configuration special instructions applicable for the maintenance release to which you are updating. You can download the latest *PTC Windchill Maintenance Read This First* for your maintenance release at the following location on the PTC website: http://www.ptc.com/appserver/cs/doc/refdoc.jsp.

This URL directs you to the PTC Online Support Web page for reference documents. For your document search criteria, select your product from the **Product** drop-down list, select the current release from the **Release** drop-down list, select **Read This First** from the **Document Type** drop-down list, and select **Administrator** from the **User Role** drop-down list.

23. When the tablespace of a modeled table is changed from WCAUDIT to some other tablespace as part of an update, the change is detected and the following script is generated during the Upgrade Database Schema phase:

```sql
<windchill>\Upgrade\UpgradeReports\UpgradeDatabaseSchema\MoveTablesSql-<date>.sql
```

If the script exists in the listed location, you need to run this script manually to move the tables to the WCAUDIT tablespace to match with an out-of-the-box database schema.

24. Bring the system back online by restarting the Windows services for Apache Web Server and Windchill server.

For more information about Windchill Service Pack updates, see the Updating an Existing Installation Help Center topic.

**Post Update Steps for Simple Number (Harvard Series) Version Scheme**

After the update has completed successfully, if your source system was set up to use the Simple Number (Harvard Series) version scheme, perform the following additional steps:

**Note**

Any existing document or CAD document has a version and iteration designator. The version scheme is Simple Number (Harvard Series) if the version of documents and CAD documents appears as $1.1, 1.2, \ldots, 2.1, 2.2, \ldots$ etc.
In a windchill shell, type the following commands to add the correct properties:


- `xconfmanager --add wt.series.HarvardSeries.seriesNames=MilSpec,Number -t codebase/wt.properties -p`

For more information about the xconfmanager Utility, see Using the xconfmanager Utility.

If these steps are not performed, the following error occurs:

```
ERROR [ajp-bio-8010-exec-1] com.ptc.core.htmlcomp.jstable.JSPersistableDataUtility cadauth - JSPersistableDataUtility.getValue :: wt.util.WTRuntimeException: Unable to construct version identifier for series: wt.series.HarvardSeries.Number; nested exception is:
java.lang.reflect.InvocationTargetException
wt.util.WTRuntimeException: Unable to construct version
```
Installing Critical Patch Sets

A Critical Patch Set (CPS) is a Windchill update that is released by PTC at regular intervals. During the installation of Windchill you must download this patch set into your staging area so that it can be included in the installation process. Critical patch sets can be found on PTC’s support page, located here:

https://www.ptc.com/appserver/cs/software_update/swupdate.jsp

**Note**

The Critical Patch Set is a self-contained download. While this download should be sufficient for most updates, in some cases you may need to download separate product installation CDs if those products are also being updated with the CPS. For more information on the products that are being updated with the CPS refer to the Critical Patch Set Release Notes.

Critical Patch Sets are installed in the same way as a typical Maintenance Release, though some of the screens and options may vary slightly.

**Note**

For more information about installing Maintenance Releases, see Updating to a New Maintenance Release on page 122.

To install the Critical Patch Set use the following procedure:

1. Download the Critical Patch Set and extract it to a Staging Directory, ensuring that all extracted files maintain the same directory structure.
2. Stop Windchill and the Apache/HTTP Server.
3. Within the Staging Directory navigate to PTCSolnInstaller.01 and click `setup.vbs` to launch the PSI.
4. Accept the license agreement.
5. When prompted, select **Update Existing Installation**.

**Update Existing Installation**

Select this option to install a product onto an existing installation, add an additional language or install a Windchill software update.

6. Select the instance to apply the CPS to and click **Next**.
7. Select **Install Critical Patch Set**.
8. Ensure that both the Critical Patch Set Staging Directory and the original Install Staging Directory are selected and click **Next**.

```
Staging Area
\\vmware-host\Shared Folders\Kits\10.2-F000
```

```
Staging Area
\\vmware-host\Shared Folders\Kits\10.2-F000\CPS
```

9. Complete the install as normal, and then restart Apache/HTTP Server.
Upgrading to a New Release of PTC Windchill PDM Essentials

PTC Windchill PDM Essentials can be upgraded to a newer major release. This upgrade process is performed the same as upgrading PTC Windchill PDMLink. For information about supported upgrade source and target releases, refer to the PTC Windchill Supported Upgrade Paths matrix.

**Note**

PTC recommends that you always use a test (pre-production) system to ensure that your Windchill products are operating as expected before deploying them in a production environment. This allows you to identify any potential issues on the test system without interfering with production system activities. After you have upgraded to the new release on a test system and are satisfied with the results, you are ready to repeat the upgrade process on your production system. Because of the work you did on your test system, upgrading on your production system should take less time.

If you choose to upgrade your production server directly, make sure to back up the server and database or take a snapshot if you deployed in a virtual environment. This enables you to restore your system if there is an issue with the upgrade. Backup details are available as part of the procedures in this section.

PTC Windchill PDM Essentials 10.1 Upgrade to PTC Windchill PDM Essentials 10.2

Before upgrading, ensure that your target system is set up properly according to the PTC Windchill PDM Essentials 10.2 prerequisites. For more information, see Prerequisites on page 11.

**Note**

During the upgrade process, the term “source system” refers to your existing installation of PTC Windchill PDM Essentials 10.1 and the term “target system” refers to the new installation of PTC Windchill PDM Essentials 10.2 that you are installing and upgrading to.
The PTC Windchill PDM Essentials upgrade process can be done using one of the following two methods:

- **Upgrading with source and target systems on same host machine (in-place upgrade) on page 135**—This upgrade method takes place with the source and target systems on the same physical or virtual machine. It is useful if you are not changing hardware as part of your upgrade. Make sure to run a test upgrade on a clone of the production server before upgrading the production server itself.

- **Upgrading with source and target systems on separate host machines on page 140**—This upgrade method is best if you are upgrading to new hardware and allows for test upgrades to the target system before opening it to production.

**Upgrading with Source and Target Systems on Same Host Machine (In-Place Upgrade)**

This upgrade method takes place with the source and target systems on the same physical or virtual machine. This method is useful if you are not changing hardware as part of your upgrade. Make sure to run a test upgrade on a clone of the production server before upgrading the production server itself.

1. Shut down the Windchill server and backup the database, Windchill Directory Server, and file vaults before performing a test or production upgrade.

2. Download and install the latest WinDU and WinRU patches for the source system release level from the following URL: [http://www.ptc.com/support/windu.htm](http://www.ptc.com/support/windu.htm). The Windchill Diagnostic Utility (WinDU) detects corruptions or issues that would cause upgrade failure or data corruption. The Windchill Repair Utility (WinRU) is a tool that fixes various data integrity problems that are reported by WinDU. You can find documentation for the Windchill Diagnostic Utility by clicking the link for the Windchill Diagnostic Utility and downloading the latest documentation.

3. On the source system, make sure the Windchill server, Apache server, and LDAP are running, and then execute the WinDU.bat script from a Windchill shell to launch WinDU.

4. Run upgrade-mandatory Windchill Diagnostic Utility (WinDU) tasks on the source system and resolve any reported issues. Ignore the ESI Schema Detector task. For more information, refer to the WinDU and WinRU guides available at the following URL: [http://www.ptc.com/support/windu.htm](http://www.ptc.com/support/windu.htm).

To help with entering the correct information in the upgrade manager, the pre-upgrade Windchill Diagnostic Utility (WinDU) task Upgrade Property Collector is executed on the source system. This WinDU task gathers information about the source system and adds it to the GatheredSourceUpgrade.properties file in the `<Windchill>/Upgrade/` directory. The Upgrade Manager uses this file during the Gather Upgrade Properties and Gather System Properties phases to pre-populate
many fields and simplify the process of gathering system configuration information needed for upgrading. If the GatheredSourceUpgrade.properties file was not used, the fields can be edited manually.

Windchill Repair Utility (WinRU) tasks are available to repair problems. Contact PTC technical support for help resolving issues. The PTC eSupport portal provides the resources and tools to support your PTC Windchill implementation: https://www.ptc.com/appserver/cs/portal/

5. Shut down the Apache and Windchill servers.
6. Backup the source database (SQL Server 2008 R2) and export LDAP at the same time:

Caution

Windchill must be shut down before performing this step.

For more information about exporting and backing up a SQL Server database, see Backing Up the SQL Server Source Database.

Use the LDAP export settings illustrated in the following image:

For more information, see Exporting Entries to an LDIF File.
7. Launch the **Windchill Installation Assistant** for the PTC Windchill PDM Essentials target release to which you are upgrading.

The **Windchill Installation Assistant** detects the existing installation of PTC Windchill PDM Essentials and, on the **Options** page, auto-selects **Installation for Upgrade** under **Install Options**.

Specify all required information and complete the **Windchill Installation Assistant** of the target release of PTC Windchill PDM Essentials. It is not necessary to execute the **Windchill Setup Assistant** because the configuration information will be migrated from the source database. For more information, see **Installation and Configuration on page 19**.
8. Import the source system’s LDAP data into the target system Windchill Directory Server. Windchill Directory Server is installed and running on the target system after performing the installation at `<Windchill>\WindchillDS`. Use the LDAP import settings illustrated in the following image.

For more information, see Importing Entries.

9. Start the target system Windchill Apache.
10. Perform the following steps to use the file output by the Upgrade Property Collector WinDU task:

a. On the target system, create the GatherUpgradeProperties folder in the following location: `<Windchill>/Upgrade/UpgradePhases`.

b. Copy the GatheredSourceUpgrade.properties file from the source system to the following location on the target system: `<Windchill>/Upgrade/UpgradePhases/GatherUpgradeProperties/`.

c. Rename the GatheredSourceUpgrade.properties file in the target location to upgradeUser.properties.

For more information about the Windchill Diagnostic Utility, refer to the following URL: http://www.ptc.com/support/windu.htm.

11. Launch the Upgrade Manager by executing UpgradeManager.bat from a Windchill shell.

12. Execute the Upgrade Manager according to the steps in the `PTC Windchill Upgrade Guide`.

13. Upgrade the SQL Server 2008 R2 database to SQL Server 2012. The SQL Server 2012 installer is found in the PTC Windchill PDM Essentials media, navigate to the `SQLServer2012` directory and execute `setup.exe`. For more information, refer to the Microsoft documentation.

14. Use the SQL Server Collation Conversion Utility to move the data from the source SQL Server 2008 R2 system to the installed SQL Server 2012 target database using Changing SQL Server Database Collation procedure.

15. From a Windchill shell, execute the following commands to ensure Windchill uses the target database on SQL Server 2012 UTF16:

a. `xconfmanager -s wt.pom.jdbc.service=<SQL_Server_Instance_Name> -t "db/db.properties" -p`

b. `xconfmanager -s wt.pom.jdbc.host=<SQL_Server_Host_Name> -t "db/db.properties" -p`

c. `xconfmanager -s wt.pom.jdbc.port=<SQL_Server_Port> -t "db/db.properties" -p`

16. After validating the target system, use the ServiceTool utility to recreate Windows services for Apache, Windchill Directory Server, and Windchill:


b. In a Windows command prompt, navigate to the following location, where `<Installation>` is the PTC Windchill PDM Essentials installer folder:
`<Installation>\Scripts`

c. Execute the following command, where `<Windchill>` is the location of your new target PTC Windchill PDM Essentials installation:
`ServiceTool <Windchill>\Windchill`
Upgrading with Source and Target Systems on Separate Machines

Upgrading with the source and target systems on separate machines involves first upgrading the SQL Server 2008 R2 database, and then moving the upgraded information to the SQL Server 2012 database on the target system. This process requires that you have a source host, a target host, and a third host (an interim host) for upgrading the SQL Server 2008 R2 database before moving the data to the target SQL Server 2012 database. This upgrade method is best if you are upgrading to new hardware and allows for test upgrades to the target system before opening it to production.

The following is a high-level overview of the PTC Windchill PDM Essentials upgrade process:

1. Shut down the Windchill server and backup the database, Windchill Directory Server, and file vaults before performing a test or production upgrade.

2. Download and install the latest WinDU and WinRU patches for the source system release level from the following URL: http://www.ptc.com/support/windu.htm. The Windchill Diagnostic Utility (WinDU) detects corruptions or issues that would cause upgrade failure or data corruption. The Windchill Repair Utility (WinRU) is a tool that fixes various data integrity problems that are reported by WinDU. You can find documentation for the Windchill Diagnostic Utility by clicking the link for the Windchill Diagnostic Utility and downloading the latest documentation.

3. On the source system, make sure the Windchill server, Apache server, and LDAP are running, and then execute the WinDU.bat script from a Windchill shell to launch WinDU.

4. Run upgrade-mandatory Windchill Diagnostic Utility (WinDU) tasks on the source system and resolve any reported issues. Ignore the ESI Schema Detector task. For more information, refer to the WinDU and WinRU guides available at the following URL: http://www.ptc.com/support/windu.htm.

To help with entering the correct information in the upgrade manager, the pre-upgrade Windchill Diagnostic Utility (WinDU) task Upgrade Property Collector is executed on the source system. This WinDU task gathers information about the source system and adds it to the GatheredSourceUpgrade.properties file in the <Windchill>/Upgrade/ directory. The Upgrade Manager uses this file during the Gather Upgrade Properties and Gather System Properties phases to pre-populate many fields and simplify the process of gathering system configuration information needed for upgrading. If the GatheredSourceUpgrade.properties file was not used, the fields can be edited manually.
Windchill Repair Utility (WinRU) tasks are available to repair problems. Contact PTC technical support for help resolving issues. The PTC eSupport portal provides the resources and tools to support your PTC Windchill implementation: https://www.ptc.com/appserver/cs/portal/

5. Shut down the Apache and Windchill servers.
6. Backup the source database (SQL Server 2008 R2) and export LDAP at the same time:

![Warning]
Windchill must be shut down before performing this step.

For more information about exporting and backing up a SQL Server database, see Backing Up the SQL Server Source Database.

Use the LDAP export settings illustrated in the following image:

For more information, see Exporting Entries to an LDIF File.
7. Install PTC Windchill PDM Essentials 10.2 on the target system. For detailed information, see Installation and Configuration on page 19. Once you have executed the **Windchill Installation Assistant**, your target server is ready for the upgrade. It is not necessary to execute the **Windchill Setup Assistant** because the configuration information will be migrated from the source system.

8. On the interim server, restore the backup of the SQL Server 2008 R2 source server database to a different SQL Server 2008 R2 server and reconfigure the user log-on according to the “Restoring the SQL Server Database” procedure in the *PTC Windchill Upgrade Guide*. 
9. Import the source system’s LDAP data into the target system Windchill Directory Server. Windchill Directory Server is installed and running on the target system after performing the installation at `<Windchill>\WindchillDS`. Use the LDAP import settings illustrated in the following image.

For more information, see Importing Entries.

10. Start the target system Windchill Apache.
11. Perform the following steps to use the file output by the Upgrade Property Collector WinDU task:

   a. On the target system, create the `GatherUpgradeProperties` folder in the following location: `<Windchill>/Upgrade/UpgradePhases`.

   b. Copy the `GatheredSourceUpgrade.properties` file from the source system to the following location on the target system:
      `<Windchill>/Upgrade/UpgradePhases/GatherUpgradeProperties/`.

   c. Rename the `GatheredSourceUpgrade.properties` file in the target location to `upgradeUser.properties`.

   For more information about the Windchill Diagnostic Utility, refer to the following URL: [http://www.ptc.com/support/windu.htm](http://www.ptc.com/support/windu.htm).

12. Launch the Upgrade Manager on the interim system by executing `UpgradeManager.bat` from a Windchill shell.

13. Perform the upgrade according to the steps in the *PTC Windchill Upgrade Guide*. The restored SQL Server 2008 R2 instance on the interim system is the “target” system during this process.

14. Use the SQL Server Collation Conversion Utility to move the data from the restored and upgraded SQL Server 2008 R2 interim system to the installed SQL Server 2012 target system using the *Changing SQL Server Database Collation* procedure. The “source” database in this procedure is the restored and upgraded SQL Server 2008 R2 database on the interim server.

15. From a Windchill shell, execute the following commands to ensure Windchill uses the target database on SQL Server 2012 UTF16:

   a. `xconfmanager -s wt.pom.jdbc.service=<SQL_Server_Instance_Name> -t "db/db.properties" -p`

   b. `xconfmanager -s wt.pom.jdbc.host=<SQL_Server_Host_Name> -t "db/db.properties" -p`

   c. `xconfmanager -s wt.pom.jdbc.port=<SQL_Server_Port> -t "db/db.properties" -p`
Moving Up to PTC Windchill PDMLink

An existing installation of PTC Windchill PDM Essentials can be upgraded to PTC Windchill PDMLink. This process is called moving up. Moving up creates an installation of PTC Windchill PDMLink that uses the same database that your previous installation of PTC Windchill PDM Essentials used, making all of your existing data available for use with the full functionality of PTC Windchill PDMLink.

After moving up, you must manage profiles in order to give users access to functionality in PTC Windchill PDMLink that was not available in PTC Windchill PDM Essentials. For more information, see Managing Profiles Moving Up on page 146.

Your existing installation of PTC Windchill PDM Essentials must be the same release as your planned target installation of PTC Windchill PDMLink. If you are planning to move up from PTC Windchill PDM Essentials to a newer release of PTC Windchill PDMLink, you must first update or upgrade your existing installation of PTC Windchill PDM Essentials to the same release level as your planned target implementation of PTC Windchill PDMLink; then you can move up to PTC Windchill PDMLink. For more information, see

- Updating to a New Maintenance Release on page 122
- Upgrading to a New Release of PTC Windchill PDM Essentials on page 134
- Supported upgrade and move-up paths

Use the following procedure to move up to PTC Windchill PDMLink:

1. Launch PSI:
   a. Insert the PTC Solution Installer CD.
   b. From a command prompt window, navigate to your CD drive, and then enter the following command: `setup.vbs`
      
      The PSI opens.

2. Choose the language for this installation session and click **OK**.
3. Accept the PTC Customer License Agreement.
4. Choose **Update Existing Installation** and click **Next**.

**Note**

The process of moving up to PTC Windchill PDMLink does not create a new installation. Rather, your current PTC Windchill PDM Essentials installation is moved up to PTC Windchill PDMLink.

5. From the list of installations to update, select your existing instance of PTC Windchill PDM Essentials, and then click **Next**.
6. On the Select Product page, select Move up to PTC Windchill PDMLink, and then click Next.
7. Review the update installation settings and click Install. The move up to PTC Windchill PDMLink begins.
8. When the move up is complete, on the Installation Results page, click Done.
9. Start the PTC HTTP Server, the PTC Windchill Directory Server, the PTC Windchill PDMLink server, and the database.

Managing Profiles Moving Up

In order for users to use the parts and change management features of PTC Windchill PDMLink, existing profiles must be modified or new profiles created:

**Note**

The following procedure is completed in the PTC Windchill PDMLink client. The PTC Windchill PDMLink system must be up and running before you begin.

- Modifying existing profiles—The easiest way to give users access to parts and change management features in PTC Windchill PDMLink is to modify the PTC Windchill PDM Essentials out-of-the-box profiles. Modifying these out-of-the-box profiles gives all participants who are members of the corresponding groups access to the features you specify. PTC recommends you modify the CAD Author and Contributor profiles. When editing each profile on the Set Action Visibility step of the Edit Profile window, in the Profile Actions table, select the appropriate checkboxes for the following actions:
  - View Change Monitor page
  - Create Parts
  - Create Change Requests
  - Create Change Notices
  - View Part Configurations
  - View Part Instances
  - View Related Changes
  - View Change Baseline Report
  - View Related Part Alternates
  - View Related Part Substitutes
  - View Related Parts

For more information, see Editing a Profile.
For more information about the PTC Windchill PDM Essentials out-of-the-box profiles, see Participants on page 58.

• Create new profiles—If you do not want to allow access to parts and change management for all participants in one of the out-of-the-box profiles, you can create new profiles and either associate specific users, or create new organization groups to associate with the new profiles.

For example, create a profile called “Full Change” and one called “Full Part.”

1. On the Set Action Visibility step of the New Profile window, in the Profile Actions table, select the appropriate checkboxes for the following actions:

<table>
<thead>
<tr>
<th>Full Change</th>
<th>Full Part</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Change Monitor page</td>
<td>Create Parts</td>
</tr>
<tr>
<td>Promote</td>
<td>View Part Configurations</td>
</tr>
<tr>
<td>Create Change Requests</td>
<td>View Part Instances</td>
</tr>
<tr>
<td>Create Change Notices</td>
<td>View Related Part Alternates</td>
</tr>
<tr>
<td>View Related Changes</td>
<td>View Related Part Substitutes</td>
</tr>
<tr>
<td>View Change Baseline Report</td>
<td>View Related Parts</td>
</tr>
</tbody>
</table>

**Note**

If other actions are applicable to the profile you are creating, select the appropriate checkboxes.

2. You can add participants to profiles using one of the following options:

○ In the Profile Members table, of the Select Members step, add participants directly to Full Change that you want to have access to change management, and add participants to Full Part that you want to have access to creating and managing parts.

OR

○ Create organization groups for the new profiles using the Participant Administration utility:

a. Create an organization group called “Full Change” and one called “Full Part.”

b. Add members to the Full Change group that you want to have access to change management, and add members to Full Part that you want to have access to creating and managing parts.
c. On the Assign to Profiles step of the New Group window, search for and select the Full Change profile for the Full Change group, and the Full Part profile for the Full Part group.

Note

Alternatively, groups can be added as members of a profile from the Edit Profile window. For more information, see Editing a Profile.

Participants that are members of the Full Change group have access to change management features, and participants that are members of the Full Part group have access to part features.

For more information, see Creating a New Profile and Creating a New Group.
Using the Windchill Help Center

The Windchill Help Center provides one searchable location for documentation on Windchill solutions and products.
The Windchill Help Center is automatically installed locally with PTC Windchill PDM Essentials. Once Windchill is installed, launch the Windchill Help Center by clicking one of the following:

- Quick Links menu in the upper-right corner of the Windchill screen
- Help buttons throughout the user interface

Note

The Windchill Help Center is also available on https://www.ptc.com/appserver/cs/help/help.jsp.

Initially, the help center displays documentation for all products. Use profiling in order to view only the documentation describing functionality available with PTC Windchill PDM Essentials.

1. Under the configuration tab, click the profile settings icon.
2. Under Product, select the Windchill PDM Essentials checkbox.
3. Select the Save Configuration Settings checkbox at the bottom of the pane, and click Submit.
Now only topics relevant to PTC Windchill PDM Essentials are displayed in the table of contents and returned in search results.